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active cell
The cell that has the focus in the grid in the Criteria pane or the Data pane.



     Add Criteria button
A button on the Microsoft Query toolbar you click to specify a criterion that selects only 
those records containing the same value as the active cell.



    Add Tables button
A button on the Microsoft Query toolbar you can click to display the Add Tables dialog box, 
where you select the tables you want to add to your query.    Clicking this button is the 
same as choosing Add Tables from the Records menu.



additional (And) criteria
Criteria you add to criteria already displayed in the Criteria pane with the And operator.    
Only records that satisfy all criteria are displayed in the result set.



alternative (Or) criteria
Criteria you add to criteria already displayed in the Criteria pane with the Or operator.    
Records that satisfy either one of the criteria are displayed in the result set.



API
Application programming interface.    A set of routines that an application, such as Microsoft
Access, uses to request and carry out lower-level services.



application
A computer program that can manipulate text, numbers, graphics, or a combination of 
these elements.



argument
A value you supply to a function.



    Automatic Query button
A button on the Microsoft Query toolbar you can click to have queries run automatically as 
you design them or to have them run only when you choose Query Now from the Records 
menu or click the Query Now button.    Clicking the Automatic Query button is equivalent to 
choosing Automatic Query from the Records menu.



Avg
A type of Total calculation you specify to display the average value for a field.



Best Fit button
A button in the Column Width dialog box you click to have Microsoft Query automatically 
adjust the width of the selected column in the Data pane so as to display the longest value.



Boolean
A value that can be evaluated only as either true or false.



buffer
An area of memory used for temporary storage.



calculated field
A field that displays the result of a calculation performed on values in other fields rather 
than data stored in a data source.    This is an example of a calculated field:
Sum(Unit_Price)/Sum(Quantity)



catalog
The system tables or data dictionary maintained in the data source.    The catalog contains 
information about the structure of the database, including table and field names, data 
types, and privileges.



catalog stored procedure
(SQL Server) A stored procedure that you execute to find out about a database's catalog, 
which includes information about the structure of the database.



cell
The intersection of a row and column in the grid in the Criteria pane or the Data pane.



Clipboard
The temporary storage area used by the operating environment to store text, graphics, and
other data.    In Microsoft Query, you transfer the data to and from the Clipboard using the 
Copy, Copy Special, and Paste commands on the Edit menu.



column
The visual representation of a field in a query's result set; a column shows values in that 
field for every record in the result set or table.    In some contexts, "field" is used in place of 
"column."



column heading
The heading that appears above each column in the first row of the result set.    The column
heading displays the name of the field in the underlying table or a new name, which you 
provide in the Edit Column dialog box.



comparison operator
An operator you use to compare two values or expressions.    The comparison operators are 
= (equal to), <> (not equal to), < (less than), > (greater than), <= (less than or equal to), 
and >= (greater than or equal to).



connection
The link between an application, such as Microsoft Excel, and a data source.



constant
A value that doesn't change.



Count
A type of Total calculation you specify to display the number of values in a field.



criteria
One or more conditions you specify to limit which records are included in a query's result 
set.    For example, the following criterion selects records for which the Order Amount value 
is greater than 30,000:
Order Amount > 30000



Criteria pane
The pane in the Query window that displays the criteria you specify.    The information you 
enter in the Criteria pane limits which records are included in the result set.



Cue Cards
An online coach that walks you through the most common Microsoft Query tasks as you 
work with your own data.    Choose Cue Cards from the Help menu in Microsoft Query for 
Windows or from the Window menu in Microsoft Query for the Macintosh.



current record
The record in the Data pane that contains the insertion point.



cursor
In SQL (Structured Query Language), a cursor points to the current row in a table, which 
can then be updated or deleted.



data
The information stored in tables or files in a data source.



data dictionary
The system tables or catalog maintained in the data source.    The data dictionary contains 
information about the structure of the database, including table and field names, data 
types, and privileges.



Data pane
The pane in the Query window that displays the result set produced by a query.    It 
occupies the lower portion of the window when the Criteria pane or Table pane is also 
displayed.



data type
The attribute of a field that determines what kind of data it can hold.    In Microsoft Query, 
available data types depend on the data source you're using.    For example, data types for 
fields in a dBASE data source include Date, Memo, and Numeric. 



database
A collection of data that is related to a particular subject or purpose.    Within a database, 
information about a particular entity, such as an employee or order, is stored in a record, 
which includes one or more fields. 



data source
A data source includes the data a user wants to access and the information needed to get 
to that data.    Examples of data sources are:

A directory or folder containing a set of dBASE files you want to access.
A SQL Server database, the server on which it resides, and the network used to 

access that server.



Data Sources button
A button in the Execute SQL dialog box that you choose to select a data source.



DBMS
Database management system.    The software used to organize, analyze, search for, 
update, and retrieve data.



DDE
Dynamic data exchange.    A mechanism supported by Microsoft Windows or Apple 
Macintosh System 7 that enables two applications, such as Microsoft Query and Microsoft 
Excel, to exchange data.



DDE channel
The conduit that applications use to transmit information to each other in a dynamic data 
exchange (DDE) conversation.



DDE conversation
The interaction between two applications that are communicating and exchanging data 
through dynamic data exchange (DDE).    In a DDE conversation, the destination application
initiates the interaction about a particular topic, and the source application responds.



DDE topic
The subject of a dynamic data exchange (DDE) conversation; the topic represents some 
unit of data meaningful to the source application.    Examples of topics include file names 
and worksheet names.



DDL
Data definition language.    An SQL (Structured Query Language) statement used to define 
data objects (tables, columns, and so on) and their attributes.    Examples include CREATE 
TABLE, DROP VIEW, and GRANT statements.



destination application
The application that initiates a DDE (dynamic data exchange) conversation.    The 
application that responds is called the source application.



destination document
A document containing a dynamic data exchange (DDE) link to a source document.



DLL
Dynamic-link library.    A set of routines that one or more applications can use to perform 
common tasks.    Open Database Connectivity (ODBC) drivers are DLLs.



DML
Data manipulation language.    An SQL (Structured Query Language) statement that can be 
used to manipulate data.    Examples include UPDATE, INSERT, and DELETE statements.



dynamic data
A copy of a query's result set (pasted into an application using the Paste command or its 
equivalent) that is updated whenever data in the result set to which it is linked changes.



empty field
A field in a particular record that doesn't contain a value.    For example, if your table 
includes a Middle Initial field, the field will be empty for those people who have no middle 
name.



empty string
A zero-length string.    Usually arises in the context of Open Database Connectivity (ODBC) 
function arguments.



equi-join
The default join type in Microsoft Query; also known as an inner join.    When a query is run 
on two tables joined by an equi-join, the result set includes only records in which the values
in the two tables' matching fields are equal.



expression
A combination of operators, field names, functions, literals, and constants that evaluates to
a single value.    In Microsoft Query, you can use an expression to specify criteria (for 
example, ORDER_AMT > 10000) or to perform a calculation on field values (for example, 
Price*Quantity).



extension
An Open Database Connectivity (ODBC) feature not in the SQL Access Group standard.    
ODBC implements two levels of extended functionality.



field
A category of information, such as last name or order amount, that is stored in a table or 
file.    When Microsoft Query displays a result set in the Data pane, a field is represented as 
a column.    In some contexts, "column" is used in place of "field."



field list
A box that lists the names of all the fields in a table.    Microsoft Query displays a table's 
field list in the Table pane.



focus
The item with the focus can receive user input through the mouse or keyboard.



font
A graphic design applied to all numerals, symbols, and alphabetic characters.    Arial and 
Courier are examples of fonts.    Fonts usually come in different sizes, such as 9- and 10-
point, and various styles, such as bold and italic.



font style
The way a font is displayed on screen or in print.    For example, a font can appear as bold, 
italic, or bold italic.



foreign key
One or more table fields that refer to the primary key field or fields in another table.



function
A procedure that returns a value based on the results of a calculation or other operation.



grouping level
The order in which Microsoft Query performs the grouping operation on multiple columns in
the result set.      When a total is calculated on a column in the result set, Microsoft Query 
automatically groups and subgroups the values in any untotaled columns.    Microsoft Query
groups the values in the leftmost untotaled column first, then subgroups the values in the 
next untotaled column, and so on. It calculates the total at the last grouping level.    
For example, suppose a query's result set includes the STATE, CITY, and ORDER_AMT 
columns (positioned in that order in the Data pane), and you sum the values in the 
ORDER_AMT column. Microsoft Query groups like values in the STATE column first, then 
groups all the like cities within each state, and finally displays the sum of order amounts for
each city in a state.



 Help button
A button on the toolbar you can click to get context-sensitive Help.    When you click this 
button, a question mark appears next to the pointer.    You can then click the command or 
interface item on which you want help.



identifier
In an expression, the name of a field.



inner join
Also known as an equi-join, which is the default join type in Microsoft Query.    When a query
is run on two tables joined by an inner join, the result set includes only records in which the
values in the two tables' matching fields are equal.



input argument
A literal, an expression, or the name of a field that is passed to a procedure and that 
contains values used by the procedure.



ISAM
Indexed sequential access method.    A method for efficiently locating file data whereby an 
index for each record is stored in a small index file, and the rest of the record is stored in a 
large data file.



join
An operation that relates the data in two tables that have at least one field in common.    A 
join is represented in the Table pane by a line between the tables' field lists.



join line
In the Table pane, the line that connects either the fields that two tables have in common 
or the fields whose values you want to compare.    The join line tells Microsoft Query how to 
relate the two sets of data.



key
One or more fields in a table that identify a record.



left outer join
A join that includes all the records from the first (left-hand) table, even if there are no 
matching values for records in the second (right-hand) table.



link
A connection between a source document and a destination document.      A link inserts a 
copy of information from the source document into the destination document while 
maintaining the connection between the two documents.      When the information changes 
in the source document, the changes are reflected in the destination document.    



literal
A number, a date, or text that Microsoft Query uses as entered.    For example, the number 
25, the string "Hello", and the date #01-05-95# are all literals.    You can use literals in an 
expression.



locked field or record
The condition of a record, field, or other object that makes it read-only to you.



Max
A type of Total calculation you specify to display the highest value in a field.



Min
A type of Total calculation you specify to display the lowest value in a field.



multiple-table query
A query that retrieves data from more than one table.



navigation buttons
The four arrows in the lower-left corner of the Data pane.    You click the arrows to move to 
the first, last, next, or previous record.



    New Query button
A button on the Microsoft Query toolbar you can click to create a new query.    Clicking this 
button is the same as choosing New Query from the File menu.



Null
A word you can use in an expression with Is to find all records that don't contain a value in 
a specified field.



ODBC
Open Database Connectivity.    A Driver Manager and a set of ODBC drivers that enable 
applications to use SQL (Structured Query Language) as a standard language to access 
data.



ODBC Administrator
The utility you use with Microsoft Windows version 3.0 to install Open Database 
Connectivity (ODBC) drivers and add, modify, and delete data sources.    (If you're using 
Windows version 3.1, you start the utility by clicking the ODBC option in the Control Panel 
window.)



ODBC Control Panel option
The utility you use with Microsoft Windows version 3.1 to install Open Database 
Connectivity (ODBC) drivers and add, modify, and delete data sources.    (If you're using 
Windows version 3.0, you start the utility by double-clicking the ODBC Administrator icon in
the ODBC group.)



ODBC Driver Manager
A dynamic-link library (DLL) that provides access to Open Database Connectivity (ODBC) 
drivers.



ODBC driver
A dynamic-link library (DLL) that an Open Database Connectivity (ODBC)-enabled 
application, such as Microsoft Excel, can use to gain access to a particular data source.    
Each database management system, such as SQL Server or dBASE, requires a different 
driver.



 Open Query button
A button on the Microsoft Query toolbar you can click to open an existing query.    Clicking 
this button is the same as choosing Open Query from the File menu.



operand
A field name or literal in an expression that is acted on by an operator.    For example, in the
expression Quantity + 1, Quantity and 1 are operands, and + is the operator.



operator
A symbol or word, such as > and Or, that indicates an operation to be performed on one or 
more elements.    Microsoft Query supports arithmetic, comparison, and logical operators.



Other button
A button in the Select Data Source dialog box that you choose to make a new data source 
available.



outer join
A join that includes all the records from one table and only those records from the other 
table for which values in the joined fields meet the condition specified in the Operator box 
in the Joins dialog box.



output argument
A field or value returned by a procedure.



owner
The person who created the table or set of tables.



pane
An area of the Query window that you can resize to view more or less of the information it 
contains.    The Query window is divided into three panes: the Table pane, the Criteria pane,
and the Data pane.



parameter
A value supplied to an SQL (Structured Query Language) statement that is treated like a 
variable by the program.



parts
The segments of a long data value as they are retrieved.



password
A unique string of characters that a user enters as an identification code to access one or 
more files or applications on a secure system.



point size
The unit of measurement used to describe the height of a printed character.    A point 
equals approximately 1/72 of an inch, or 1/28 of a centimeter.



primary key
One or more fields whose values uniquely identify each record in a table.



procedure
A series of commands that are stored on a server and that perform a specific operation, 
such as returning a result set or updating data.



query
A means of finding the records that answer a particular question you ask about the data 
stored in a data source. 



query channel
A channel used for a dynamic data exchange (DDE) conversation between a destination 
application and a specific query in Microsoft Query.



query definition
Information that Microsoft Query uses to connect to and decide which data to retrieve from 
a data source.    It can include table names, field names, and criteria,    A query definition is 
sent to a data source for execution in the form of an SQL (Structured Query Language) 
statement.



query design
The elements you include in the Query window for a particular query, their characteristics, 
and the relationship between the elements.    A query's design includes the tables you add 
to the Table pane, any criteria you specify in the Criteria pane, the order in which you place
columns and their headings in the Data pane, and the font you specify for the result set.    
In addition, a query's design establishes query mode (whether Automatic Query is on or 
off), editing status (whether Allowed Editing is checked or unchecked), and the visibility of 
panes and columns.



    Query Now button
A button on the Microsoft Query toolbar you can click to run a query when the Automatic 
Query option is off.    Clicking this button is the same as choosing Query Now from the 
Records menu.



Query window
A window in which you design, edit, and run a query.    The Query window is divided into 
three panes: the Table pane, the Criteria pane, and the Data pane.    You can have more 
than one Query window open at once.



record
A collection of information about a particular person, place, event, or thing.    When 
Microsoft Query displays a result set in the Data pane, a record is represented by a row.    In 
some contexts, "row" is used in place of "record." 



record selector
In the Data pane, a small box or bar you can click to select an entire record in the result 
set.



relationship
An association defined between common fields in two tables.    Microsoft Query uses 
relationships to create joins between tables.



Remove button
A button in the Joins dialog box that you choose to remove the join selected in the Joins In 
Query box



result set
The set of records that results from running a query.    Microsoft Query displays the result 
set in row-and-column format in the Data pane.



retrieve
To get data from a data source.



return
In Open Database Connectivity (ODBC), to send data from an application to a data source.   
In programming, functions can return a value.



return value
A single value returned for a procedure as a whole.    Generally, this value either is 
calculated by the procedure or indicates whether the procedure succeeded.    For example, 
a procedure that determines the next available employee ID returns that ID as a return 
value.    A procedure for adding records for new employees to a database returns TRUE if a 
record was successfully added and FALSE if the record wasn't added.



right outer join
A join that includes all the records from the second (right-hand) table, even if there are no 
matching values for records in the first (left-hand) table.



row
The physical representation of a single record in a query's result set; each cell in a row 
displays the value stored in a specific field for a specific record.    In some contexts, "record"
is used in place of "row."



    Save Query button
A button on the Microsoft Query toolbar you can click to save your query.    Clicking this 
button is the same as choosing Save Query from the File menu.



SELECT statement
The SQL (Structured Query Language) statement you use to retrieve specified data from a 
table.



self-join
A join between two copies of the same table.    You use a self-join to compare values within 
a single table.



server
A computer that acts as a controller or as a data repository in a multiuser environment.



    Sort Ascending button
A button on the Microsoft Query toolbar you can click to sort records in ascending order (A
Z, 0
9).    Clicking this button is the same as selecting Ascending in the Sort dialog box.



    Sort Descending button
A button on the Microsoft Query toolbar you can click to sort records in descending order (Z
A, 9

0).    Clicking this button is the same as selecting Descending in the Sort dialog box.



sort order
The order in which records are displayed in the Data pane either ascending (A
Z or 0
9) or descending (Z
A or 9
0).



source application
The application that responds to a destination application's request to initiate a dynamic 
data exchange (DDE) conversation and supply data to it.



source document
A document in a source application, which supplies data in a dynamic data exchange (DDE)
conversation.



split bar
A horizontal bar that separates the Query window's panes.    You can resize the panes by 
dragging the split bar up or down.



SQL
Structured Query Language.    A language used for retrieving, updating, and managing 
data.



SQL dialog box
A box that displays the SQL (Structured Query Language) statement on which the active 
query is based.    To see the SQL dialog box, choose SQL from the View menu or click the 
View SQL button.



SQL statement
An instruction written in SQL (Structured Query Language) that provides the information 
(such as a field name, a table name, and criteria) that Microsoft Query needs to execute a 
query.    A query definition is sent to a data source for execution in the form of an SQL 
statement.



static data
A copy of a query's result set that is not updated when data in the result set from which it 
was copied changes.



string
A collection of characters that can include both numbers and text.



sub-SELECT statement
A SELECT statement that is nested inside another SELECT, INSERT, DELETE, or UPDATE 
statement.    For example, in the following statement, which retrieves a list of employees 
who are as old as John Smith, the SELECT statement in parentheses is a sub-SELECT 
statement:
SELECT NAME, AGE FROM EMPLOYEES
WHERE AGE = (SELECT AGE FROM EMPLOYEES WHERE NAME = 'John Smith')



Sum
A type of Total calculation you specify to display the sum of values in a field.



synonym
An alternate name given to a table.    This name is permanently stored in the data source.



system channel
A channel used for a dynamic data exchange (DDE) conversation between a destination 
application and Microsoft Query itself.



system table
A table that contains information about the structure of a database.    For example, table 
names, column (field) names, and column data types are usually kept in system tables.



table
A collection of data about a specific topic that is stored in records (rows) and fields 
(columns). 



table definition
A description of a table in a data source. This may include the name of the table, the name,
type, and length of each column, and table and column privileges, such as whether users 
can update the table or column.



Table pane
The pane in the upper portion of the Query window.    The Table pane contains tables' field 
lists.



Total calculation
One of the five calculation types Microsoft Query defines for you: Sum, Avg, Count, Min, and
Max.



Total field
A field on which you perform a Total calculation, such as Sum or Avg.



Total box
A box in the Add Column, Insert Column, and Edit Column dialog boxes in which you can 
select the type of Total calculation you want Microsoft Query to perform.



    Totals button
A button on the Microsoft Query toolbar you can click to have Microsoft Query perform a 
Total calculation, which you choose, on values in the selected field (column).



translation option
An option that specifies how a translator translates data.    For example, a translation option
might specify the character sets between which a translator translates character data.    It 
might also provide a key for encryption and decryption.



translator
A dynamic-link library (DLL) that translates all data passing between an application, such 
as Microsoft Access, and a data source.    The most common use of a translator is to 
translate character data between different character sets.    A translator can also perform 
tasks such as encryption and decryption or compression and expansion.



underlying table
A table in a data source that contains the data Microsoft Query retrieves and displays in the
result set.



Use button
A button in the Select Data Source dialog box you choose to tell Microsoft Query which data
source you want to retrieve data from.



user
A person who can view the data in a table.



value
The contents of a field.



Values button
A button in the Add Criteria dialog box you choose to display a list of values you can use to 
specify the criteria for the field selected in the Field box.



view
In SQL, an alternate way of looking at data from one or more tables.    For example, the 
following statement creates a view that contains all the employees in Department 101:
CREATE VIEW Dept101 AS
SELECT * FROM EMPLOYEES WHERE DEPT = 101
When you modify the data in a view, you are actually modifying the data in the underlying 
tables.



    View Criteria button
A button on the Microsoft Query toolbar you can click to display or hide the Criteria pane.    
Clicking the View Criteria button has the same effect as choosing Criteria from the View 
menu.



    View SQL button
A button on the Microsoft Query toolbar you can click to display or modify the SQL 
(Structured Query Language) statement for the active query.    Clicking this button is the 
same as choosing SQL from the View menu.



    View Tables button
A button on the Microsoft Query toolbar you can click to show or hide the Table pane.    
Clicking this button is the same as choosing Tables from the View menu.



wildcard character
A keyboard character you use to represent one or many characters.    In Microsoft    Query, 
an underscore (_) is a wildcard character that can stand for any single character, and a 
percent sign (%) can represent any number of characters.



Zoom Field box
An expanded text box in which you can enter or modify the contents of a field more 
conveniently.    Choose Zoom Field from the View menu.





Restore Command (Control Menu)
See Also

Returns the active window to its size and position before being maximized or minimized.
Shortcuts

Mouse: Click        in a maximized window.
Double-click a minimized window's icon.
Double-click the title bar of a maximized Query window.



See Also
Maximize Command (Control Menu)
Minimize Command (Control Menu)



Move Command (Control Menu)
See Also

Enables you to move the active window or dialog box using the arrow keys.
Microsoft Query displays a four-headed arrow.    Press the appropriate ARROW key to move 
the window or dialog box in the desired direction, and then press ENTER to complete the 
move.

Note      The Move command is unavailable when the active window is maximized.



See Also
Maximize Command (Control Menu)
Minimize Command (Control Menu)
Size Command (Control Menu)



Size Command (Control Menu)
See Also

Allows you to change the size of the active window using the arrow keys.
Microsoft Query displays a four-headed arrow.    Press the appropriate ARROW key to size the
window, and then press ENTER to complete the operation.

Note      The Size command is unavailable when the active window is maximized.



See Also
Maximize Command (Control Menu)
Minimize Command (Control Menu)
Move Command (Control Menu)



Minimize Command (Control Menu)
See Also

Reduces the active window to an icon. When minimized, the Microsoft Query application 
window is reduced to an icon on the Microsoft Windows desktop.    A Query window within 
Microsoft Query, when minimized, is reduced to an icon in the Microsoft Query application 
window.

Shortcut

Mouse: Click        in the upper-right corner of a window.



See Also
Maximize Command (Control Menu)
Restore Command (Control Menu)
Size Command (Control Menu)



Maximize Command (Control Menu)
See Also

Enlarges the active window. When maximized, the Microsoft Query application window 
expands to fill the entire screen.    A Query window within Microsoft Query, when 
maximized, expands to fill the Microsoft Query window.

Shortcuts

Mouse: Click        in the upper-right corner of a window.
Double-click a window's title bar.



See Also
Minimize Command (Control Menu)
Restore Command (Control Menu)



Close Command (Control Menu)
See Also

Quits Microsoft Query or closes the active window or dialog box.    To quit Microsoft Query, 
choose Close from the Control menu of the Microsoft Query application window.    To close a 
window or dialog box, choose Close from the Control menu of the window or dialog box.
If you are quitting Microsoft Query and have made changes to a query's design, Microsoft 
Query asks if you want to save them.    You don't need to save changes to data; Microsoft 
Query saves data automatically.

Shortcuts

Mouse: Double-click        to quit Microsoft Query or to close a dialog box.

Double-click        to close a window within Microsoft Query.
Keys: Press ALT+F4 to quit Microsoft Query or close a dialog box.

Press CTRL+F4 to close a window within Microsoft Query.



See Also
Close Query Command (File Menu)
Exit Command (File Menu)



Switch To Command (Control Menu)
See Also

Displays the Task List window, which lists all open applications in Microsoft Windows. Use 
the Task List to switch to or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Makes the windows of open applications overlap so you can see each title bar.    This option 
doesn't affect applications reduced to icons.
Tile
Arranges the windows of open applications into windows that don't overlap.    This option 
doesn't affect applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



See Also
Next Command (Control Menu)



Next Command (Control Menu)
See Also

Switches to the next open window within Microsoft Query.    Which window opens next is 
determined by the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



See Also
Switch To Command (Control Menu)



Add Criteria Command (Criteria Menu)
See Also

Displays the Add Criteria dialog box in which you define the criteria that records must meet
to be included in the result set.    For example, you can specify criteria to select only records
that contain a certain value (such as records for suppliers in Japan) or records that fall 
within a range (such as employees with start dates between 1-Jan-91 and 1-Jan-92).

Notes
The first time you add criteria to a query, Microsoft Query displays the Criteria pane.
You can add criteria in three places: the Add Criteria dialog box, the Add Criteria 

button, or the Criteria pane.    The Add Criteria button has some limitations on the criteria 
you can specify.    See "Using the Add Criteria Button to Specify Criteria" in Chapter 4, 
"Retrieving the Records You Want," of the Microsoft Query User's Guide.

Criteria must be in the form of an expression.    When you specify criteria using the 
Add Criteria dialog box or the Add Criteria button, Microsoft Query translates the criteria into
an expression.    When you specify criteria in the Criteria pane, you type the expression 
yourself.    For more information about expressions, see "Specifying Criteria Using an 
Expression" in Chapter 4, "Retrieving the Records You Want," of the Microsoft Query User's 
Guide.

If the Automatic Query option is turned on, it slows down the query design process 
because Microsoft Query runs your query each time you change the criteria.    To turn this 
option off, choose Automatic Query from the Records menu or click the Automatic Query 
button on the toolbar.
Shortcut

Toolbar: Click        to use the current value in the Data pane as a criterion for selecting 
records.    (The Add Criteria dialog box doesn't appear.)

Dialog Box Options
And
Select this option if you are specifying new criteria and both the existing and the new 
criteria must be true. 
Or
Select this option if you are specifying alternative criteria and either the existing or the new
criteria must be true.
Total
Use this option to set criteria for a field for which you calculated a total.    Select both the 
type of total you want to calculate on the field specified in the Field box and the criteria you
want the totaled values to meet in the result set.

Note      If you want to set criteria that limits the records Microsoft Query uses to calculate a
total, you may need to use the "Where" item in the Total box.    For more information, see 
"Specifying Criteria in Queries Containing Totals" in Chapter 5, "Performing Calculations on 
Data," of the Microsoft Query User's Guide.

Field
Select the field for which you want to specify criteria.
Operator
Select the criterion (operator) that must be true for the field you selected.
Value



Type the value you want Microsoft Query to use when selecting records for the result set.    
(Or use the Values button, as described below.)
Values
Displays the Select Values dialog box.    You select from a list of values to use for the 
criterion.    These values are taken from the field for which you're specifying criteria.
Add
Adds the criteria you specify to the query.    If Automatic Query is on, only the records that 
meet the criteria appear in the result set.    The Add Criteria dialog box remains open so you
can add more criteria.
Close
Closes the Add Criteria dialog box.



See Also
Help:

Expressions Overview
Remove All Criteria Command (Criteria Menu)

Cue Cards:
Criteria Expressions
Multiple Criteria
Multiple Criteria for a Field
Retrieve Records
Retrieve Values to Total
View the Criteria Pane

User's Guide:
Chapter 4, "Retrieving the Records You Want"
Chapter 5, "Performing Calculations On Data"



Remove All Criteria Command (Criteria Menu)
See Also

Removes all criteria specified in a query.    

Notes
If Automatic Query is turned on, Microsoft Query displays all records in the result set 

after you choose Remove All Criteria.    (Automatic Query is on when the Automatic Query 
button is recessed or Automatic Query on the Records menu is checked).

If Automatic Query is turned off, you must click the Query Now button on the toolbar 
or choose Query Now from the Records menu to display all the records.



See Also
Help:

Add Criteria Command (Criteria Menu)
Criteria Command (View Menu)

Cue Cards:
Delete a Cell of Criteria

User's Guide:
Chapter 4, "Retrieving the Records You Want"



New Query Command (File Menu)
See Also

Displays an empty Query window in which you create a query.    Microsoft Query first 
displays the Select Data Source dialog box, in which you choose the data source you want 
to use for the new query. 
Once you've chosen a data source, Microsoft Query displays the Add Tables dialog box, 
where you choose the tables from which you want to retrieve data.

Notes
If the data source you want isn't in the Available Data Sources list, choose the Other 

button in the Select Data Source dialog box to display the ODBC Data Sources dialog box.
If the data source you want isn't listed in the ODBC Data Sources dialog box, choose 

the New button to display the Add Data Source dialog box in Microsoft Query for Windows or 
the Select DBMS Driver dialog box in Microsoft Query for the Macintosh. In this dialog box 
you can add a new data source for any of the ODBC drivers installed on your machine.
Shortcut

Toolbar: Click        to create a new query.



Add Tables Dialog Box
The options in the Add Tables dialog box vary depending on the data source you're using.    
Click one of the answers below to view Help on the Add Tables dialog box for your data 
source.

How does your data source store data?
In files used as tables (as do Microsoft Excel and Microsoft Word)
In tables (as do SQL Server and Microsoft Access)



See Also
Help:

Add Data Sources for Installed Drivers
Open Query Command (File Menu)

Cue Cards:
Add a Table
An Example of a Query
Choose a Data Source
Create a New Query
What Is a Query?
What Is a Table?
Which Tables Should I Add?

User's Guide:
Chapter 1, "Getting Started with Queries"
Appendix B, "ODBC Drivers: Requirements, Installation, and Adding Data Sources"



Select Data Source Dialog Box
Displays a list of data sources that you've previously used and that are currently available 
for querying, for defining tables, or for viewing or deleting table definitions.    
Microsoft Query displays this dialog box when you choose any of the following commands    
(or, if they have them, their toolbar equivalents) from the File menu:

New Query 
Save As
Table Definition
Execute SQL (and then choose the Data Sources button)

Dialog Box Options
Available Data Sources
Select the data source you want to use or remove from the list. 

Note      When you choose Save As to display the Select Data Source dialog box, the Save 
As list includes the item QRY File in Microsoft Query for Windows and MS Query File in 
Microsoft Query for the Macintosh.    You select this item to save the query's design.    You 
select a specific data source to save the query's result set as a table.

Use
Tells Microsoft Query to use the data source you select in the Available Data Sources list for 
the task you want to perform. 

Note      Some data sources display an additional dialog box requesting more information, 
such as a user ID, password, database, or directory or folder.    The dialog box varies 
depending on the data source you're using.

Cancel
Closes the Select Data Source dialog box, disregarding any selections you've made.
Other 
Choose this if the data source you want isn't listed in the Select Data Source dialog box.    
Microsoft Query displays the ODBC Data Sources dialog box.    
Remove
Removes the selected data source from the Available Data Sources list.    Choose this if you 
don't want the data source to appear in the list.    (You can add it later if necessary.)

Note      Microsoft Query won't remove a data source if an open query is using the data 
source.



ODBC Data Sources Dialog Box
See Also

Displays a list of data sources you can make available for querying.    

Note      After you choose a data source from the list, Microsoft Query closes this dialog box 
and redisplays the Select Data Source dialog box.    The data source you selected now 
appears in the Available Data Sources list.    (The data source is still listed in the ODBC Data
Sources dialog box, in case you need more than one connection to that data source, or if 
you remove the data source from the Available Data Sources list and want to add it again 
later.)

Dialog Box Options
Enter Data Source
Type the name of the data source in the first box, or select a data source from the list below
it.
OK 
Closes the dialog box and redisplays the Select Data Source dialog box with your data 
source added to the Available Data Sources list.
Cancel
Closes the dialog box and redisplays the Select Data Source dialog box without adding a 
data source to the Available Data Sources list.
New
Choose this if your data source isn't listed in the ODBC Data Sources dialog box.    This 
button displays the Add Data Source dialog box in Microsoft Query for Windows and the 
Select DBMS Driver dialog box in Microsoft Query for the Macintosh.
Remove
Choose this to remove a selected data source from the list.    You can add this data source 
again by choosing the New button, and then respecifying the driver and the data source 
setup information.



See Also
Execute SQL Command (File Menu)
New Query Command (File Menu)
Save As Command (File Menu)
Table Definition Command (File Menu)



Add Data Source Dialog Box (Windows)
See Also 

Displays a list of ODBC drivers installed on your machine.    Use this dialog box to add data 
sources to the ODBC Data Sources dialog box.    Once a data source is listed in that dialog 
box, you can make it available for querying in the Select Data Source dialog box.

Dialog Box Options
Installed ODBC Drivers
Select the driver for the data source you want to add.

Note      Microsoft Query displays another dialog box specific to the data source you're 
adding that requests additional information, such as the network path, the name you want 
to use for the data source, user ID, and password.

OK
Closes the Add Data Source dialog box and redisplays the ODBC Data Sources dialog box 
with the data source you just added.
Cancel
Closes the Add Data Source dialog box and redisplays the ODBC Data Sources dialog box 
without adding any data sources.



See Also
Add Data Sources for Installed Drivers
Execute SQL Command (File Menu)
New Query Command (File Menu)
Save As Command (File Menu)
Table Definition Command (File Menu)



Open Query Command (File Menu)
See Also

Displays the Open Query dialog box, from which you open an existing query for viewing or 
editing.    The Open Query dialog box is also displayed when you choose the Open button in 
the Execute SQL dialog box.    From the dialog box, you can open an SQL file whose SQL 
statement you want to view, edit, or run.

Notes
When you choose Open Query from the File menu, Microsoft Query opens the query 

you select in the Query window, displaying tables in the Table pane (if they were displayed 
when the query was last saved) and the result set in the Data pane.    When you choose the 
Open button in the Execute SQL dialog box, Microsoft Query displays the SQL statement you 
select in the SQL Statement box.

You can have more than one query open at a time, but you can have only one SQL 
file open at a time.
Shortcut

Toolbar: Click        to open a query.
Dialog Box Options 
In Microsoft Query for Windows:
File Name
Type the name of the query or SQL file you want to open, or select a name from the list.
Microsoft Query lists files with the extension you select in the List Files Of Type box.
List Files Of Type
For a query, select the type of file you want to see listed in the File Name list.    Select QRY 
Files (*.qry) to see a list of all files in the current directory saved with the Microsoft 
Query .QRY extension.    Select Q+E Files (*.qef) to see a list of the files in the current 
directory saved with the Q+E .QEF extension.    With an SQL file, the default is SQL File 
(*.qrt).
Directories
Select the directory where the file you want to open is stored.
Drive 
Select the drive where the file you want to open is stored.

Dialog Box Options 
In Microsoft Query for the Macintosh:
<Drive>
Select the drive where the file you want to open is stored.
<Folder name>
Select the folder where the file you want to open is stored.
List Files Of Type
Displays the format of the files listed in the dialog box.    The format is either MS Query File 
or SQL File.
Read Only
Select this check box if you want to view the file but don't want to save changes to it.



See Also
Help:

Close Query Command (File Menu)
Exit Command (File Menu - Windows)
New Query Command (File Menu)
Quit Command (File Menu - Macintosh)

Cue Cards:
Close a Query
Modify a Query
Open an Existing Query
Save a Query
Work with Data

User's Guide:
Chapter 1, "Getting Started with Queries"



Close Query Command (File Menu)
See Also

Closes the active Query window when you no longer need it for the current working 
session.    

Notes
If you made any changes to the query's design and haven't saved the query, 

Microsoft Query prompts you to save your changes.    If you choose the OK button but 
haven't previously named the query, the Save As dialog box is displayed.

You don't have to save changes to data before closing the query.    Microsoft Query 
saves data automatically when you leave a record or close the query.
Shortcuts
Keys: In Microsoft Query for Windows, CTRL+F4 

In Microsoft Query for the Macintosh (extended keyboard), CONTROL+F4



See Also
Help:

Exit Command (File Menu - Windows)
Open Query Command (File Menu)
Quit Command (File Menu - Macintosh)
Save Query Command (File Menu)

Cue Cards:
Close a Query
Open an Existing Query
Save a Query

User's Guide:
Chapter 1, "Getting Started with Queries"



Save Query Command (File Menu)
See Also

Saves a query's design, replacing any previous version with the current version.    If you 
haven't saved the query before, Microsoft Query displays the Save As dialog box.

Notes
You don't need to save the query's data.    Microsoft Query saves data automatically 

when you leave a record or close your query.
Use the Save As command instead if you need to:
Save a new query.
Save a copy of the active query under a different name.
Save a query's result set as a table.

Shortcuts

Toolbar: Click        to save a query.
Keys: In Microsoft Query for Windows, ALT+SHIFT+F2 or SHIFT+F12

In Microsoft Query for the Macintosh, SHIFT+F12 (extended keyboard) or COMMAND+S



See Also
Cue Cards:

Save a Query
Save Your Data

User's Guide:
Chapter 1, "Getting Started with Queries"



Save As Command (File Menu)
See Also

Displays the Save As dialog box, which you use to save a new query's design, an existing 
query's design under a different name, or a query's result set as a table.    Microsoft Query 
also displays this dialog box when you choose the Save button in the Execute SQL dialog 
box.    In the dialog box, you can save a new SQL statement or an existing SQL statement 
under a different name.
When you choose this command from the File menu, Microsoft Query displays the Select 
Data Source dialog box first.    You can choose to save either your query's design (by 
selecting QRY File in the Save As list in Microsoft Query for Windows or MS Query File in 
Microsoft Query for the Macintosh) or your query's result set as a table (by selecting the 
specific data source where you want to store the table).    

Shortcuts
Keys: To bring up the Select Data Source dialog box when saving a query's design or 

result set:
In Microsoft Query for Windows, ALT+F2 or F12 
In Microsoft Query for the Macintosh, F12 (extended keyboard) 

Dialog Box Options (Save As Dialog Box)
The following dialog box options apply when you:

Select QRY File in the Select Data Source dialog box in Microsoft Query for Windows 
or MS Query File in Microsoft Query for the Macintosh.

Save a result set as a table to a data source that uses files as tables (such as a data 
source based on Microsoft Excel or Microsoft Word).

Choose Save from the Execute SQL dialog box to save an SQL statement.
If you're saving a result set to a data source that doesn't use files as tables (such as a data 
source based on SQL Server or Microsoft Access), see the Save As Table dialog box options 
at the end of this topic instead.
In Microsoft Query for Windows: 
File Name
Type a name for the query or SQL statement you want to save or the table you want to 
create from the result set.    For the query or SQL statement name, you can use up to eight 
characters (not including the optional extension).    For limitations on the table name, check
the documentation for your data source. 
List Files Of Type
If you're saving a query's design, this section displays QRY File (*.qry).    If you're saving a 
result set as a table, it displays the appropriate extension for the data source where you're 
saving the table.    If you're saving an SQL file, it displays SQL File (*.qrt).
Directories
Select the directory where you want to save the query, table, or SQL statement.
Drive
Select the drive where you want to save the query, table, or SQL statement.

Dialog Box Options (Save As Dialog Box)
In Microsoft Query for the Macintosh:
Save As
Type a name for the query or SQL statement you want to save or the table you want to 
create from the result set.



<Drive>
Select the drive where you want to save the file.
<Folder name>
Select the folder where you want to save the file.
New
Choose this button to create a new folder in which you want to save the file.
Save File As Type
Displays the format in which Microsoft Query will save the file.    The format is either MS 
Query File or SQL File.
Read Only
Select this check box if you want to save the file as a write-protected file.

Dialog Box Options (Save As Table Dialog Box)
Table Name
Type a name for the table you want to create from the result set.
Database
Choose the database (or its equivalent) where you want to store the table.
Save Indexes
Leave this option checked if the result set you're saving as a new table came from a table 
that already contained an index.    Microsoft Query will try to create an index on the same 
fields in the new table.



See Also
Help:

Close Query Command (File Menu)
Exit Command (File Menu - Windows)
Quit Command (File Menu - Macintosh)
Save a Query's Result Set as a Table
Save Query Command (File Menu)

Cue Cards:
Close a Query
Save a Query

User's Guide:    
Chapter 1, "Getting Started With Queries"
Chapter 7, "Creating and Deleting Tables"



Table Definition Command (File Menu)
See Also

Enables you to view or delete an existing table definition, to create a new table, or to 
create an index on one or more fields in a table.    
When you select this command, Microsoft Query displays the Select Data Source dialog 
box, where you can select the data source containing the table definition you want to work 
with or the data source for which you want to create a new table or an index on an existing 
table.    Microsoft Query then displays the Select Table dialog box, where you choose to view
or remove an existing table's definition or to create a new table or index. 

Note      When you create a new table from an existing table's definition, Microsoft Query 
doesn't add the data in the existing table to the new table.    The new table is empty.



See Also
Help:

Create a New Table
Delete a Table

User's Guide:
Chapter 7, "Creating and Deleting Tables"



Select Table Dialog Box
Microsoft Query has two types of Select Table dialog boxes: one for data sources (such as 
those based on Microsoft Excel and Microsoft Word) that store data in files used as tables 
and another for data sources that store data in tables (as do SQL Server and Microsoft 
Access).
Click one of the answers below to display the Select Table dialog box options for your data 
source.

How does your data source store data?
In files used as tables 
In tables 



Select Table Dialog Box (for files used as tables)
See Also

Displays a list of tables whose definitions you can view or delete.    You can also create a 
new table definition or create an index on an existing table.    
If your data source stores data in files used as tables, Microsoft Query displays the following
options in the Select Table dialog box.

Dialog Box Options
In Microsoft Query for Windows:
Table Name
Type the name of an existing table whose definition you want to work with, or select a 
name from the list.
List Files Of Type
Displays the extension for the table in the data source you're using.
Directories
Select the directory for the existing table you want to use or where you want to store the 
new table.
Drive
Select the drive for the existing table you want to use or where you want to store the new 
table.
View 
Displays the View Table Definition dialog box, which has the definition of the table you 
selected. 
New 
Displays the New Table Definition dialog box, which has blank fields that allow you to define
a new table.
Remove
Deletes the table you selected in the Table Name box. 

Warning      When you choose Remove, Microsoft Query prompts you to confirm the 
deletion. If you choose the Yes button, Microsoft Query deletes the table and all the data 
stored in it. Once this happens, you can't undo your deletion from within Microsoft Query.

Index
Displays the Create Index dialog box where you create an index on one or more fields in a 
table.
Close
Closes the Select Table dialog box.

Dialog Box Options
In Microsoft Query for the Macintosh:
<Drive>
Select the drive for the existing table you want to use or where you want to store the new 
table.
<Folder name>
Select the folder for the existing table you want to use or where you want to store the new 
table.



List Files Of Type
Identifies the type of files listed in the dialog box (such as dBASE files) for the data source 
you're using.
View 
Displays the View Table Definition dialog box, which has the definition of the table you 
selected. 
New 
Displays the New Table Definition dialog box, which has blank fields that allow you to define
a new table.
Remove
Deletes the table you selected in the Select Table dialog box. 

Warning      When you choose Remove, Microsoft Query prompts you to confirm the 
deletion. If you choose the Yes button, Microsoft Query deletes the table and all the data 
stored in it. Once this happens, you can't undo your deletion from within Microsoft Query.

Index
Displays the Create Index dialog box where you create an index on one or more fields in a 
table.
Close
Closes the Select Table dialog box.



See Also
Select Table Dialog Box (for tables)
Table Definition Command (File Menu)



Select Table Dialog Box (for tables)
See Also

Displays a list of tables whose definitions you can choose to view or delete.    You can also 
create a new table definition or create an index on an existing table.
If your data source stores data in tables, Microsoft Query displays the following options in 
the Select Table dialog box.

Dialog Box Options
Table 
Type the name of the table whose definition you want to work with, or select a name from 
the list.
Owner 
Choose the owner whose tables you want listed in the Table list.    (The label for this item 
may vary depending on the data source.)
Database 
Choose the database (or database equivalent) containing the table definition you want to 
work with or where you want to create a new table definition.    (The label for this item may 
vary depending on the data source.)
View 
Displays the View Table Definition dialog box, which has the definition of the table you 
selected. 
New 
Displays the New Table Definition dialog box, which has blank fields that allow you to define
a new table.
Remove
Deletes the table you selected in the Table list.

Warning      When you choose Remove, Microsoft Query prompts you to confirm the 
deletion. If you choose the Yes button, Microsoft Query deletes the table and all the data 
stored in it. Once this happens, you can't undo your deletion from within Microsoft Query.

Index
Displays the Create Index dialog box where you create an index on one or more fields in a 
table.
Close
Closes the Select Table dialog box.
Options
Displays the Table Options dialog box, enabling you to control which tables are listed in the 
Select Table dialog box.



See Also
Select Table Dialog Box (for files used as tables)
Table Definition Command (File Menu)



Create Index Dialog Box
Enables you to create an index on one or more fields in a table.    You create an index for a 
table to help Microsoft Query find values more quickly in fields that you search or sort 
often.    Microsoft Query looks up the location of the data in the index.    
The Create Index dialog box is displayed in the following situations:

When you choose the Index button in the Select Table dialog box.
When the result set you're saving as a new table came from a table that either had 

no index or had an index that Microsoft Query couldn't create for the new table.
Dialog Box Options
Table Name
Displays the name of the table for which you are creating an index.
Index Name
Type the name you want to assign to the index.    (When you want to remove the index, you
reference this name in a DROP INDEX SQL statement.) 

Note      Requirements for index names vary depending on the data source.    See the 
documentation for your data source for more information.

Index Fields
Indicate the field or fields on which you want to create an index using one of these 
methods:    (1) selecting one of the table's field names from the list; (2) entering one or 
more of the field names separated by commas (such as LAST_NAME,FIRST_NAME); or (3) 
entering an expression (such as PRICE*QUANTITY).
Unique Index
When checked, indicates that the values in the field or fields on which you created the 
index uniquely identify each record in the table.    
Add
Adds the index on the field or fields you specified from the table. 
Close
Closes the Create Index dialog box.



New/View Table Definition Dialog Box
See Also

Displays one of the following:
If you've chosen the New button in the Select Table dialog box, Microsoft Query 

displays the New Table Definition dialog box, which has blank fields that allow you to define 
a new table.

If you've chosen the View button in the Select Table dialog box, Microsoft Query 
displays the View Table Definition dialog box, which has the definition of the table you 
selected in the Table list in the Select Table dialog box.
Dialog Box Options
Table Name
Type a name for your new table, or replace the name of the table you're using as a 
template with the name you want for the new table.

Note      The number and type of characters allowed in the table name vary depending on 
your data source.    For more information, see the documentation that came with the driver 
your data source uses, or contact the driver vendor.    (If your data source uses an ODBC 
driver that came with Microsoft Query for Windows, click "ODBC Drivers" in the Microsoft 
Query Help Contents, and then click the name of the driver.)

Field Description
Field Name Type a name for a field that will be in the table.
Type Select the type of data that will be stored in the field.    (The available data 

types depend upon your data source.) 
Length Type the number of characters that can be entered as a value in a field.    

Using this option to limit field size helps prevent data-entry errors and may 
save disk space.    (This option may not be available for some data types.)

Decimal Type the number of decimal places you want to display.    (This option may 
not be available for some data types.)

Required Select this option to require that data be entered in the field.
Add
Adds the field you defined to the table.    Choose this button each time you complete the 
Field Description section for a field you're adding to the table.

Note      You can't edit a field once you've added it.    If you need to make changes to a field,
remove it with the Remove button (described below) and then add it again with the 
changes you want.

Remove
Removes the field you select in the Fields box from the query.
Fields
Displays the names and definitions of all fields in the table.
Create
Creates the table with the fields you've defined.    Microsoft Query displays a message 
confirming that the table was created successfully.
Cancel
Closes the Table Definition dialog box and redisplays the Select Table dialog box.



See Also
Select Table Dialog Box (for files used as tables)
Select Table Dialog Box (for tables)
Table Definition Command (File Menu)



Execute SQL Command (File Menu)
See Also

Executes a new or existing SQL statement or procedure.    Use this command to run a query
that you can't create in the Query window, such as one that grants privileges, modifies 
existing tables, or creates indexes on data.

Notes
If the statement or procedure returns more than one result set, Microsoft Query 

displays only the first one in the Data pane.
If the statement or procedure is successful but isn't the type that returns a result set, 

Microsoft Query displays a message that the query or procedure was executed successfully. 
If the statement or procedure wasn't executed successfully, Microsoft Query displays 

the appropriate error message (from the data source).
Microsoft Query won't execute procedures that have output arguments and won't 

show a return value from a function.
Dialog Box Options
SQL Statement
Type the SQL statement you want to execute.    If you open an existing SQL file with the 
Open button, Microsoft Query displays the statement in this box.
Data Sources
Displays the Select Data Source dialog box.    Select the data source for the table on which 
you want to run the SQL statement or that contains the procedure you want to execute.
Database 
Select the database for the table on which you want to run the SQL statement or that 
contains the procedure you want to execute.    (The name of this item may vary, depending 
on the data source.)
Execute
Executes the statement or procedure and displays its result set (if any) in the Query 
window. 
Cancel 
Closes the dialog box without executing an SQL statement or procedure.
Open
Displays the Open Query dialog box, enabling you to open an existing SQL file and display 
its contents in the SQL Statement box.
Save
Displays the Save As dialog box, where you can save an SQL statement or procedure.    You 
can save a new statement, save changes to an existing statement, or save a copy of an 
existing statement or procedure under a new name.
Procedures
Displays the Select Procedure dialog box, in which you select the procedure you want to 
execute.



See Also
Help:

Create a Query Using a Custom SQL Statement
Execute Procedures
SQL Command (View Menu)
View or Edit an Existing Query's SQL SELECT Statement

User's Guide:
Chapter 8, "Working with SQL"



Select Procedure Dialog Box
See Also

Displays a list of procedures from the current data source that you can execute.
Dialog Box Options
Procedure
Select the procedure you want to execute.
Paste
Pastes the procedure into the SQL Statement box in the Execute SQL dialog box, where you
can execute it.
Cancel
Redisplays the Execute SQL dialog box.    No procedure is pasted into it.



See Also
Execute SQL Command (File Menu)



Exit Command (File Menu Windows)
See Also

Quits Microsoft Query for Windows and closes any open Query windows.    

Notes
If you started Microsoft Query from another application, the Exit command is replaced

by a command that you use to return data from Microsoft Query to the original application. 
The name of the command varies depending on the application from which you started 
Microsoft Query.

If you made any changes to a query's design and haven't saved the query, Microsoft 
Query prompts you to save your changes.    If you choose the Yes button but haven't 
previously named the query, the Save As dialog box is displayed.

You don't have to save changes to data before closing the query.    Microsoft Query 
saves data automatically when you leave a record or close the query.

If you created a new query but haven't saved it yet, Microsoft Query asks if you want 
to save the query.    If you choose the Yes button, Microsoft Query prompts you for a name. 
Shortcut
Keys: ALT+F4



See Also
Help:

Close Query Command (File Menu)
Cue Cards:

Close a Query
Copy Data to Another Application

User's Guide:
Chapter 1, "Getting Started with Queries"



Quit Command (File Menu Macintosh)
See Also

Quits Microsoft Query for the Macintosh and closes any open Query windows.    

Notes
If you started Microsoft Query from another application, the Quit command is 

replaced by a command that you use to return data from Microsoft Query to the original 
application. The name of the command varies depending on the application from which you 
started Microsoft Query.

If you made any changes to a query's design and haven't saved the query, Microsoft 
Query prompts you to save your changes.    If you choose the Yes button but haven't 
previously named the query, the Save As dialog box is displayed.

You don't have to save changes to data before closing the query.    Microsoft Query 
saves data automatically when you leave a record or close the query.

If you created a new query but haven't saved it yet, Microsoft Query asks if you want 
to save the query.    If you choose the Yes button, Microsoft Query prompts you for a name. 
Shortcut
Keys: COMMAND+Q



See Also
Help:

Close Query Command (File Menu)
Cue Cards:

Close a Query
Copy Data to Another Application

User's Guide:
Chapter 1, "Getting Started with Queries"



Select DBMS Driver Dialog Box (Macintosh)
See Also

Displays a list of ODBC drivers installed on your machine.    Use this dialog box to add data 
sources to the ODBC Data Sources dialog box.    Once a data source is listed in that dialog 
box, you can make it available for querying in the Select Data Source Dialog Box.

Dialog Box Options
Installed ODBC Drivers
Select the driver for the data source you want to add.

Note      Microsoft Query displays another dialog box specific to the data source you're 
adding that requests additional information, such as the name you want to use for the data 
source, user ID, and password.

OK
Closes the Select DBMS Driver dialog box and redisplays the ODBC Data Sources dialog box
with the data source you added.
Cancel
Closes the DBMS Driver dialog box and redisplays the ODBC Data Sources dialog box 
without adding any data sources.



See Also
Add Data Sources for Installed Drivers
Execute SQL Command (File Menu)
New Query Command (File Menu)
Save As Command (File Menu)
Table Definition Command (File Menu)



Font Command (Format Menu)
See Also

Changes the typeface Microsoft Query uses to display field names and data in the Data 
pane.

Notes
You can display data in any font available on your computer.
Font settings affect the entire result set, not individual cells, rows, or columns.
Microsoft Query automatically adjusts row height to fit the new font if you're using 

the standard (default) row height.    If you're using a custom row height, you may need to 
adjust it to fit the font. 

Font settings are saved when you save the query.
Dialog Box Options
Font
Select a font.
Font Style
Select a font style.
Size
Select a point size.
Effects
Select to add an underline to field names and data.
Sample
Shows how your text looks in the selected font, style, and size.



See Also
Help:

Column Width Command (Format Menu)
Row Height Command (Format Menu)

Cue Cards:
Change How Data Looks
Change Row Height
Change the Font

User's Guide:
Chapter 2, "Changing How Data Looks in the Data Pane"



Row Height Command (Format Menu)
See Also

Changes the height of all rows in the Data pane.    Use this command when, for example, 
you've reduced column widths to fit more columns on one screen.    By increasing row 
height, you enable the values in the narrower columns to wrap to subsequent lines.

Notes
You can also resize row height manually by dragging the lower border of any record 

selector in the Data pane.
Row height changes are saved when you save the query.
If you're using the standard (default) row height, Microsoft Query adjusts the row 

height automatically if you change the font.    If you're using a custom row height and you 
change the font, you have to adjust row height manually to fit the font.
Dialog Box Options
Row Height
Type (in points) the height for the rows.
Standard Height
Select to apply the default height.    (The default height varies depending on the font you're 
using.)



See Also
Help:

Column Width Command (Format Menu)
Font Command (Format Menu) 

Cue Cards:
Change Column Width
Change How Data Looks
Change Row Height
Change the Font

User's Guide:
Chapter 2, "Changing How Data Looks in the Data Pane"



Column Width Command (Format Menu)
See Also

Changes the width of the selected column in the Data pane.    You can change column 
widths when, for example, you want to display more columns on one screen.

Notes
Changing the font size can change the number of characters displayed in the column 

but doesn't change the column width.
Changing the width of a column doesn't affect the field length defined in the table's 

definition.
Column width changes are saved when you save the query.

Dialog Box Options
Column Width
Type the number of characters you want the column to display based on the current font.    
(Microsoft Query may actually display fewer characters in a field to compensate for 
uppercase letters or any letters that are not average size for that font.)
Standard Width
Select to apply the default width.    (The default width varies depending on the font used in 
the Data pane.)
Best Fit
Select to adjust the column width automatically to the largest value displayed in the 
selected column on the screen.



See Also
Help:

Font Command (Format Menu)
Hide Columns Command (Format Menu)
Row Height Command (Format Menu)

Cue Cards:
Change Column Width
Change Column Width to Best Fit
Change Row Height
Change the Font
Hide Columns 
Show Hidden Columns

User's Guide:
Chapter 2, "Changing How Data Looks in the Data Pane"



Hide Columns Command (Format Menu)
See Also

Temporarily hides the selected column.
Use this command to remove data temporarily from the Data pane.

Notes
You can use values from a hidden column to set criteria.
If columns are hidden when you save a query, they remain hidden when you reopen 

that query. 
To see a list of hidden columns, choose Show Columns from the Format menu.    The 

hidden columns don't have a check mark next to them in the Show Columns dialog box.



See Also
Cue Cards:

Hide Columns
Move Columns in the Data Pane
Show Hidden Columns

User's Guide:
Chapter 2, "Changing How Data Looks in the Data Pane"



Show Columns Command (Format Menu)
See Also

Displays or hides the specified column in the Data pane.
Use this command to display hidden columns or temporarily hide displayed columns.    You 
can also choose Hide Columns from the Format menu to hide selected columns.

Notes
In the Show Columns dialog box, a check mark appears next to each displayed 

column.    Unchecked columns are hidden.
You can use values from a hidden column to set criteria.
If columns are hidden when you save a query, they remain hidden when you reopen 

that query.    If they are displayed when you save the query, they remain displayed when you
reopen it.

When you show a hidden column, it is displayed in its original location.
You can select multiple column names in the list to display or hide.    To select a block 

of column names, click the first name in the block, and then hold down the SHIFT key and 
click the last name in the block.    To select names that aren't adjacent to each other, click 
the first name, then hold down the CTRL key in Microsoft Query for Windows and the 
CONTROL key in Microsoft Query for the Macintosh while you click subsequent names.
Dialog Box Options
Columns
Lists all columns in the Data pane alphabetically.    You can select one or more columns in 
the list to hide or redisplay.
Hide
Hides the selected columns.
Show
Shows the selected columns.
Close
Closes the Show Columns dialog box.



See Also
Cue Cards:

Hide Columns
Show Hidden Columns

User's Guide:
Chapter 2, "Changing How Data Looks in the Data Pane"



Contents Command (Help Menu)
See Also

Opens the Help window or switches to it if it's not already open and displays the Help 
Contents, which provides an overview of Help and access to all Help and Cue Cards topics.   
You can also press F1 to display 
To display context sensitive Help, do one of the following: 

press F1.
press SHIFT+F1, and then click the item that interests you.
click the Help button on the toolbar, and then click the item that interests you. 



See Also
Cue Cards Command (Help Menu)
Search Command (Help Menu)



Search Command (Help Menu)
See Also

Enables you to quickly find Help topics and cue cards about a particular subject.
Shortcut
Choose the Search button in the Help window.

Dialog Box Options
[Subject]
Type the first few letters of the subject you're interested in.    As you type, Microsoft Query 
scrolls through a list of subjects to locate a matching entry.    Double-click your subject, or 
select the subject and choose Show Topics.
Show Topics
Lists the topics or cue cards relevant to your subject.
Go To
Double-click your topic, or select the name of a topic or cue card, and then choose Go To to 
display it.



See Also
Contents Command (Help Menu)
Cue Cards Command (Help Menu)



Cue Cards Command (Help Menu)
See Also

Displays the Cue Cards main menu. Cue Cards takes you through common Microsoft Query 
tasks step by step, enabling you to create and use a query as you learn. Read About Cue 
Cards to find out more about what Cue Cards is and how to use it.



See Also
Contents Command (Help Menu)
Search Command (Help Menu)



About Microsoft Query Command (Help Menu)
See Also

Displays the Microsoft Query version number, the copyright notice, your company's name, 
your serial number, the amount of available memory, your computer's math coprocessor (if
any), and the amount of free disk space on the current drive.
Choose OK to close the dialog box and return to Microsoft Query.



See Also
Contents Command (Help Menu)



Add Column Command (Records Menu)
See Also

Adds a column (field) to the Data pane.    If there's already a result set in the Data pane, 
Microsoft Query adds the new column to the end of the result set.

Notes
If you have a column in the result set selected, this command changes to Insert 

Column.
If you add a column while Automatic Query is turned off, only the column heading is 

displayed in the Data pane.    You must choose Query Now from the Records menu to see the
result set.

You can remove a column by clicking in it and then choosing Remove Column from 
the Records menu or pressing DEL.
Dialog Box Options
Field
Select a name or type an expression for the field you want to add to the Data pane.
Column Heading 
If you want to use a different name for the field, type the name in this box. 
Total
If you want the column to display a total of the values stored in the field, select the type of 
total you want displayed.
Add 
Adds the field to the Data pane.    Once you've added a field, you can select another field to
add.
Close 
Closes the Add Column dialog box.



See Also
Cue Cards:

Add a Calculated Field
Add a Field
Add All Fields
Run a Query

User's Guide:
Chapter 1, "Getting Started with Queries"



Insert Column Command (Records Menu)
See Also

Adds a column (field) to the Data pane.    This command replaces the Add Column 
command when you've selected a column in the result set.    The Insert Column command 
inserts a column to the left of the selected column.

Notes
If you insert a column while Automatic Query is turned off, only the column heading is

displayed in the Data pane.    You must choose Query Now from the Records menu to see the
result set.

You can remove a column by clicking in it and then choosing Remove Column from 
the Records menu or pressing DEL.

Dialog Box Options
Field
Select a name or type an expression for the field you want to add to the Data pane.
Column Heading 
If you want to use a different name for the field, type the name in this box. 
Total
If you want the column to display a total of the values stored in the field, select the type of 
total you want displayed.
Insert 
Inserts the field into the Data pane.    Once you've inserted a field, you can select another 
field to insert.
Close 
Closes the Insert Column dialog box.



 See Also
Cue Cards:

Add a Calculated Field
Add a Field
Add All Fields
Run a Query

User's Guide:
Chapter 1, "Getting Started with Queries"



Remove Column Command (Records Menu)
See Also

Removes the selected column from the Data pane.

Notes
When you remove a column, you're not deleting the data from the underlying table; 

you're just removing the column and its data from your query.    
If you want a column and its data to remain in the query but not be displayed in the 

result set, choose Hide Columns from the Format menu instead.
If you change your mind after you remove a column, choose Undo Delete Column 

from the Edit menu.
You can't delete the blank column in the Data pane.



See Also
Help:

Add Column Command (Records Menu)
Delete Command (Edit Menu)
Hide Columns Command (Format Menu)
Show Columns Command (Format Menu)

Cue Cards:
Delete Part of a Query
Hide Columns
Move Columns in the Data Pane
Remove a Column of Data 
Show Hidden Columns

User's Guide:
Chapter 1, "Getting Started with Queries"



Edit Column Command (Records Menu)
See Also

Modifies the selected column with the changes you specify.    Use this command to change 
column headings and to specify the type of total you want to calculate.

Dialog Box Options
Field
Select the field (column) you want to modify in the Data pane.
Column Heading 
If you want to use a different name for the field, type the name in this box. (This doesn't 
change the column heading in the underlying table.)
Total
If you want the column to display a total of the values stored in the field, select the type of 
total you want displayed.
OK 
Makes the changes to the field in the Data pane, and then closes the Edit Column dialog 
box.    
Cancel
Closes the Edit Column dialog box without modifying a field.



See Also
Help:

Column Width Command (Format Menu)
Remove Column Command (Records Menu)

Cue Cards:
Calculate Totals
Change Column Headings
Change Column Width
Change How Data Looks
Move Columns in the Data Pane

User's Guide:
Chapter 2, "Changing How Data Looks in the Data Pane"
Chapter 5, "Performing Calculations on Data"



Sort Command (Records Menu)
See Also

Sorts the records in a query by the values in the column you select.    You can sort the 
records in ascending order (A-Z, 0-9) or descending order (Z-A, 9-0).

Notes
Rearranging the order of columns in the result set after you sort the records doesn't 

affect the sort order.
You can sort records using a field that isn't in the result set by typing the field's name

in the Column box and then choosing the Add button.
You can also sort on columns using the Sort Ascending button or Sort Descending 

button on the toolbar.    To sort on multiple columns, hold down the CTRL key in Microsoft 
Query for Windows or the CONTROL key in Microsoft Query for the Macintosh with an 
extended keyboard (otherwise, use the COMMAND key) while you click a Sort button for each 
additional sort. 
Shortcuts
Toolbar: Click        to sort on a column in ascending order.

Click        to sort on a column in descending order.
Dialog Box Options
Column
Select the column (field)you want to use for the sort.
Ascending
Sorts the records in ascending order. 
Descending
Sorts the records in descending order.
Sorts In Query
Displays the sort order for each column you sorted on.    The order in which the columns are
listed is the order in which Microsoft Query performs each sort.
Add 
Sorts on the column selected in the Column box.    When you sort on a column, the column 
is removed from the Column list and placed in the Sorts In Query box.    The Sort dialog box 
remains open so you can sort on other columns.
Close
Closes the Sort dialog box.
Remove
Removes the sort order for a column you've selected in the Sorts In Query box.    When you 
remove a column from the Sorts In Query box, it is redisplayed in the Column list in case 
you want to sort on it later.



See Also
Cue Cards:

Sort on Multiple Fields
Sort Records

User's Guide:
Chapter 2, "Changing How Data Looks in the Data Pane"



Go To Command (Records Menu)
See Also

Moves to the value in the selected field in the record you specify.    If you've selected an 
entire row in the Data pane when you choose Go To, Microsoft Query moves to and selects 
the entire row for the record you specify.

Note      You can also use the navigation buttons located in the lower-left corner of the 
Query window to move from record to record.    Click the number in the record number box, 
and then type the number of the record to which you want to move.    Press ENTER.

Dialog Box Options
Go To Record
Type the number of the record you want to go to, and then click OK.



See Also
Cue Cards:

Move to a Field
Move to a Record
Work with Data

User's Guide:
Chapter 3, "Working with Data"



Allow Editing Command (Records Menu)
See Also

Controls whether you can make changes to the data in a query's result set, thereby 
changing the data in the underlying table.

Notes
When the command is checked, you can edit the data.    If you choose the command 

again, you remove the check mark and won't be able to edit the data.
There are some situations in which you can't edit the data even when you check 

Allow Editing.    
The data source doesn't allow it.
The query has more than one table.
The query contains totals or custom expressions.
The field you're trying to edit is locked or disabled, or the field is in a record that is 

locked.
The data you're trying to edit is from a database that requires specific values in a 

field.



See Also
Cue Cards:

Add, Edit or Delete Data
Fields You Can't Edit
Values You Can't Enter
Work with Data

User's Guide:
Chapter 3, "Working with Data"



Query Now Command (Records Menu)
See Also

Runs the query and displays the most current result set in the Data pane.    Use this 
command when Automatic Query is turned off.

Note      When Automatic Query is turned on, it slows down the design process because 
Microsoft Query runs the query each time you add a field, specify criteria, or otherwise 
change the design.    By turning Automatic Query off, you can run the query only when 
you're ready by choosing Query Now.

Shortcut
Toolbar: Click        to run the query.



See Also
Cue Cards:

Run a Query
User's Guide:

Chapter 1, "Getting Started with Queries"
Chapter 4, "Retrieving the Records You Want"



Automatic Query Command (Records Menu)
See Also

Controls whether the query is run every time you change it, such as when you add fields or 
specify new criteria that records must meet.    By default, Automatic Query is turned on (a 
check mark appears next to the command).
If Automatic Query is off:

Only the field names (column headings) are displayed when you add fields to the 
Data pane.    To run the query and see data in the Data pane, you have to choose Query Now
from the Records menu.

Choosing Undo from the Edit menu causes the query to revert to the query design in 
effect the last time you ran the query.
Shortcut
Toolbar: Click        to turn Automatic Query on or off.



See Also
Cue Cards:

Run a Query
User's Guide:

Chapter 1, "Getting Started with Queries"
Chapter 4, "Retrieving the Records You Want"



Add Tables Command (Table Menu)
See Also

Displays the Add Tables dialog box, which you can use to add one or more tables to the 
Table pane in your query.    

Notes
The Table pane must be displayed to see a table's field list.    
If you add more than one copy of the same table, Microsoft Query prompts you to 

verify your action.    (You add the same table twice when you want to create a self-join.)
Microsoft Query automatically displays the Add Tables dialog box when you choose 

New Query from the File menu and then select a data source in the Select Data Source 
dialog box.    

The choices in the Add Tables dialog box vary depending on the data source you're 
using.    Click one of the answers below to display the Add Tables dialog box for your data 
source.
How does your data source store data?
In files used as tables (as do Microsoft Excel and Microsoft Word)
In tables (as do SQL Server and Microsoft Access)

Shortcut
Toolbar: Click        to display the Add Tables dialog box.



See Also
Help:

Joins Command (Table Menu)
Remove Table Command (Table Menu)
Tables Command (View Menu)

Cue Cards:
Add a Field
Add a Table
Add Fields
Create a New Query
Join Tables
What Is a Table?
Which Tables Should I Add?

User's Guide:
Chapter 1, "Getting Started with Queries"
Chapter 6, "Creating Multiple-Table Queries"



Add Tables Dialog Box (for files used as tables)
See Also

Displays a list of tables from the current data source that you can add to the Table pane in 
your query.

Dialog Box Options
In Microsoft Query for Windows:
Table 
Type the name of the table, or select a name from the list.
Microsoft Query lists tables with the file extension indicated in the List Files Of Type box. 
List Files Of Type
Displays the file extension for the tables in the data source you're using.
Directories
Select the directory where the tables you want are stored.
Drives 
Select the drive where the tables you want are stored.
Add
Adds the selected table to the Table pane.    The Add Tables dialog box remains open until 
you're done adding tables.    
Close
Closes the Add Tables dialog box.

Note      The Table pane must be displayed to see a table's field list.    When the Add Tables 
dialog box is open, you may have to move it around to see the contents of the Table pane.

Dialog Box Options
In Microsoft Query for the Macintosh:
<Drive>
Select the drive where the tables you want are stored.
<Folder name>
Select the folder where the tables you want to use are stored.
List Files Of Type
Displays the format of the files listed in the dialog box; for example "dBASE files."
Close
Closes the Add Tables dialog box.
Add
Adds the selected table to the Table pane.    The Add Tables dialog box remains open until 
you're done adding tables.    



See Also
Add Tables Command (Table Menu)
Add Tables Dialog Box (for tables)



Add Tables Dialog Box (for tables)
See Also

Displays a list of tables from the current data source that you can add to the Table pane in 
your query.

Dialog Box Options
Tables
Select the name of a table from the list.
Owner 
If you want the Tables box to display only those tables created by a specific owner, select 
that owner.    (The label for this item varies depending on the data source.)
Database 
Select the database (or its equivalent) where the tables you want are stored.    (The label 
for this item varies depending on the data source.)
Add
Adds the selected table to the Table pane.    The Add Tables dialog box remains open until 
you're done adding tables.    

Note      The Table pane must be displayed to see a table's field list.    When the Add Tables 
dialog box is open, you may have to move it around to see the contents of the Table pane.

Close
Closes the Add Tables dialog box.
Options
Displays the Table Options dialog box, which enables you to control which tables are listed 
in the Add Tables dialog box.



See Also
Add Tables Command (Table Menu)
Add Tables Dialog Box (for files used as tables)



Table Options Dialog Box
See Also

Displays options that can change the list of tables displayed in the Add Tables dialog box 
when you're using tables (not files used as tables).

Notes
The options you select become the default for the next query you create.
You can select one or more options.    Each option you select adds more table names 

to the Tables list in the Add Tables dialog box.
Dialog Box Options
Show

Tables Displays a list of 
all the tables in 
the underlying 
database (or 
database 
equivalent) in the
Add Tables dialog
box.    (By default 
this option is 
selected.) 

Views Adds the names 
of alternate 
views of any of 
the database 
tables to the Add 
Tables dialog box.
Note      This 
option isn't 
available if no 
alternate views 
exist in the 
database.

System 
Tables

Adds the names 
of system tables 
to the Add Tables
dialog box.

Synonyms Adds the 
synonyms that 
were created for 
the tables in the 
database to the 
Add Tables dialog
box.
Note      This 
option isn't 
available if no 
synonyms exist 
in the database.

Refresh



Requeries the database to ensure that the most current list of tables is displayed in the Add
Tables dialog box.
OK
Closes the Table Options dialog box to show the Add Tables dialog box with the table 
options you selected.
Cancel
Closes the Table Options dialog box to show the Add Tables dialog box without any new 
table options.



See Also
Add Tables Command (Table Menu)
Add Tables Dialog Box (for files used as tables)



Remove Table Command (Table Menu)
See Also

Removes the selected table's field list from the Table pane.    Use this command when you 
no longer want to retrieve data from the table or if you added the table in error.    

Notes
When you remove a table's field list, you're not deleting the data from the underlying 

table.    You're just removing the field list and its data from the active query.
If you change your mind, you can restore the table to the query by choosing Undo 

from the Edit menu or Add Tables from the Table menu.    (You can also click the Add Tables 
button on the toolbar.)



See Also
Cue Cards:

Delete Data
Modify a Query's Design
Remove a Table 

User's Guide:
Chapter 1, "Getting Started with Queries"



Joins Command (Table Menu)
See Also

Creates, removes, or reorders joins between tables in the Table pane.

Notes
Joined tables in the Table pane have a line (the join line) connecting a field in one 

table with the equivalent field in another table.
Microsoft Query automatically joins tables if one of the tables has a primary key field 

and another table has a field with the same name and data type.    
You can also join tables by dragging a field from one table to the equivalent field (one

of the same data type containing similar data) in another table in the Table pane.
If you add or delete a join in a query, it affects only that query. If you create a query 

that uses the same tables, Microsoft Query will create the join in the new query. 
Dialog Box Options
Left
Select the table and field you want on the left side of the join line. 
Right
Select the table and field you want on the right side of the join line.
Operator
Select the operator that determines what type of comparison Microsoft Query performs on 
the values in the joined fields.
Join Includes
Select the option that specifies which records you want to retrieve and under what 
condition (based on the comparison operator).    The option you select determines the join 
type, either an inner join or an outer join.
Option Description
1 Creates an inner join.    (This is the default.)
2 Creates a left outer join.
3 Creates a right outer join.
Joins In Query
Displays statements defining the existing joins in the active query.    If you have more than 
one join, Microsoft Query displays a separate statement for each. You can remove a join by 
selecting its corresponding statement, and then choosing the Remove button.
Add
Adds the join line between two tables in the Table pane for the join you have specified in 
the Joins dialog box.    The Joins dialog box remains open until you've added all the joins you
need.
Remove
Removes the join statement you've selected in the Joins In Query box.    (This action 
removes the join line between the two tables in the Table pane.)
Close
Closes the Joins dialog box.



See Also
Help:

Add Tables Command (Table Menu)
Create a Self-Join

Cue Cards:
Add a Table
Change Join Type
Delete a Join
Delete Part of a Query
Join Tables

User's Guide:
Chapter 6, "Creating Multiple-Table Queries"



Tables Command (View Menu)
See Also

Displays or hides the Table pane.    

Notes
When you create a new query, Microsoft Query displays the Table pane in the Query 

window.    When you open an existing query, the Table pane is displayed if it was displayed 
the last time you saved the query.    Otherwise, you have to choose Tables to display it.

Hiding the Table pane allows more room for displaying the Criteria pane or the Data 
pane.

When the Table pane is displayed, the Tables command is checked and the Tables 
button is recessed.
Shortcut
Toolbar: Click        to display or hide the Table pane.



See Also
Help:

Criteria Command (View Menu)
Cue Cards:

Add a Table
View the Criteria Pane

User's Guide:
Chapter 1, "Getting Started with Queries"



Criteria Command (View Menu)
See Also

Displays or hides the Criteria pane. 

Notes
Microsoft Query doesn't display the Criteria pane automatically when you create a 

query; however, it does display it the first time you specify criteria by choosing Add Criteria 
from the Criteria menu or clicking the Add Criteria button on the toolbar.    

When the Criteria pane is displayed, a check mark appears next to the command.
Hiding the Criteria pane allows more room for displaying the Table pane or the Data 

pane.    Choose the Criteria command again to hide the pane and remove the check mark.
When you open an existing query, Microsoft Query displays the Criteria pane if it was 

displayed the last time you saved the query.    Otherwise, you have to choose Criteria to 
display it.
Shortcut
Toolbar: Click        to display or hide the Criteria pane.



See Also
Help:

Tables Command (View Menu)
Cue Cards:

Delete a Cell of Criteria
Multiple Criteria for a Field
Specify Criteria

User's Guide:
Chapter 4, "Retrieving the Records You Want"



Zoom Field Command (View Menu)
See Also

Displays the Zoom Field box containing the contents of a field's cell in the Data pane.    Use 
the Zoom Field box when you need more room for editing or entering data. Once you've 
made the changes, the revised data appears in the Data pane.

Shortcuts
Mouse: In Microsoft Query for Windows, double-click the right mouse button.
Keys: SHIFT+F2    (If you're using Microsoft Query for the Macintosh, extended keyboard

only)



See Also
Cue Cards:

Add, Edit, or Delete Data
Delete Data in a Cell
Edit Data
Insert a Value
Replace a Value
Undo Changes to Data
Values You Can't Enter
Work with Data

User's Guide:
Chapter 3, "Working with Data"



Query Properties Command (View Menu)
See Also

Enables you to set the Unique Values Only property and the Group Records property for a 
query.

Dialog Box Options
Unique Values Only 
Select this property to hide duplicate values in your query's result set.
Group Records 
Select this property to group together all the like values in a field.    Use this property with 
the "For Each" totals option when you want to display the same total for each record in a 
group.



See Also
Cue Cards:

Hide Duplicate Data
User's Guide:

Chapter 4, "Retrieving the Records You Want"



SQL Command (View Menu)
See Also

Displays the corresponding SQL SELECT statement for the active query in the Query 
window so you can view or edit the statement. 

Note      You use this command to view or modify an existing SQL statement that returns a 
result set.    To execute a new SQL statement or an SQL statement that doesn't return a 
result set, choose Execute SQL from the File menu.

Shortcut
Toolbar: Click        to display a query's SQL SELECT statement.



See Also
Help:

Create a Query Using a Custom SQL Statement
Execute Procedures
Execute SQL Command (File Menu)
View or Edit an Existing Query's SQL SELECT Statement

User's Guide:
Chapter 8, "Working with SQL"



Tile Command (Window Menu)
See Also

Arranges Query windows in Microsoft Query side by side so all windows are visible and 
don't overlap.



See Also
Cascade Command (Window Menu)



Cascade Command (Window Menu)
See Also

Overlaps Query windows in Microsoft Query so that each window's title bar is visible.



See Also
Tile Command (Window Menu)



1,2,3, . . . 9 Command (Window Menu)
Microsoft Query can list the names of up to nine open Query windows at the bottom of the 
Window menu.    To make a window active, select its name from the list.

Notes
Microsoft Query displays a check mark next to the active window.
If more than nine windows are open, Microsoft Query displays a More Windows 

command on the menu. Choose More Windows to display a dialog box listing all open 
windows.





Function Keys
See Also

Note    Function keys are available if you're using Microsoft Query for Windows or Microsoft 
Query for the Macintosh with an extended keyboard. 

To In Windows 
press

On the 
Macintosh press

Switch to Help 
window 

F1 COMMAND+/ or HELP

Get context-
sensitive Help

SHIFT+F1 COMMAND+SHIFT+? 
or SHIFT+HELP

Select (or 
cancel 
selection of) 
current value

F2 F2 

Save query 
with Save 
command

ALT+SHIFT+F
2 or 
SHIFT+F12 

SHIFT+F12 or 
COMMAND+S

Save a query 
with Save As 
command 

ALT+F2    or 
F12 

F12 

Open Zoom 
Field dialog box
in the Data 
pane (for 
entering values
in small input 
areas more 
conveniently)

SHIFT+F2 SHIFT+F2

Close active 
query

CTRL+F4 CONTROL+F4

Quit Microsoft 
Query

ALT+F4    COMMAND+Q 

Go to a specific
record (row) in 
the Data pane

F5 (see 
following 
note)

F5 (see following 
note)

Move to next 
pane in the 
Query window

F6 F6

Move to 
previous pane 
in the Query 
window

SHIFT+F6 SHIFT+F6

Switch to next 
open Query 
window

CTRL+F6 CONTROL+F6



Switch to 
previous open 
Query window

CTRL+SHIFT
+F6

CONTROL+SHIFT+F6

Turn Extend 
mode on

F8    (see 
following 
note)

F8 (see following 
note)

Note      
To go to a specific record (row) in the Data pane, press F5 then type the number of 

the record in the record number box; press ENTER.
Once Extend mode is on, if the insertion point is in a value in a cell, pressing F8 

repeatedly extends the selection to the word containing the insertion point, and then the 
entire value.    If a row is selected, pressing F8 extends the selection to all records.    Press 
ESC to cancel Extend mode



See Also
Editing Keys
Navigation Keys
Selection Keys



Navigation Keys 
See Also

The following tables identify how to move in the Table pane, Criteria pane, and Data pane.

Note    If you're using a Macintosh, some of the key combinations listed below are available 
only with an extended keyboard.    These combinations are followed by "(extended)" in the 
list.

Moving in the Table Pane
When you move in a field list, Microsoft Query automatically selects the item you move to.

To Press
Move between 
field lists

TAB

Move to (and 
select) field 
names in a field 
list

UP ARROW or DOWN
ARROW. Select 
contiguous fields 
in a field list (or 
cancel a selection)
by pressing 
SHIFT+UP ARROW or
DOWN ARROW

Moving in the Criteria Pane and Data Pane
Move between columns and rows

To In Windows 
press

On the 
Macintosh 
press

Go to a 
specific record 
(row) in Data 
pane

F5, then type the 
number of the 
record in the 
Record Number 
box; press ENTER 

F5 (same as 
Windows)

Move to next 
column

TAB, RIGHT ARROW,
or ENTER (in the 
Data pane)

TAB, RIGHT ARROW,
or ENTER (in the 
Data pane)

Move to 
previous 
column in the 
current row or 
last field in the
previous 
record

SHIFT+TAB or LEFT 
ARROW

SHIFT+TAB or LEFT 
ARROW

Move to last 
column in 
current row

END END (extended)

Move to last 
column in last 
row

CTRL+END CONTROL+END 
(extended)



Move to first 
column in 
current row

HOME HOME (extended)

Move to first 
column in first 
row

CTRL+HOME CONTROL+HOME 

Move to 
current column
in next row

DOWN ARROW DOWN ARROW

Move to 
current column
in last row

CTRL+DOWN 
ARROW 

CONTROL+DOWN 
ARROW (extended)
or 
COMMAND+DOWN 
ARROW 

Move to 
current column
in previous 
row

UP ARROW UP ARROW

Move to 
current column
in first row

CONTROL+UP 
ARROW 

CONTROL+UP 
ARROW (extended)
or COMMAND+UP 
ARROW 

Move the insertion point within a value in a cell

To In Windows 
press

On the 
Macintosh press

(If the cell you 
want to work in 
is selected, 
press F2 to 
cancel selection 
and display the 
insertion point)
Move one 
character to the 
right

RIGHT ARROW RIGHT ARROW

Move one word 
to the right

CTRL+RIGHT 
ARROW 

CONTROL+RIGHT 
ARROW (extended)

Move one 
character to the 
left

LEFT ARROW LEFT ARROW

Move one word 
to the left

CTRL+LEFT ARROW CONTROL+LEFT 
ARROW (extended)

Move to end of 
line (in single-
line or multiple-
line values)

END END (extended)

Move to end of CTRL+END CONTROL+END 



value in 
multiple-line 
values

(extended)

Move to 
beginning of line
(in single-line or 
multiple-line 
values)

HOME HOME (extended)

Move to 
beginning of 
value in 
multiple-line 
values

CTRL+HOME CONTROL+HOME 
(extended)

Move between screens

To In Windows 
press

On the 
Macintosh press

Move down one 
screen in a pane

PAGE DOWN PAGE DOWN 
(extended)

Move up one 
screen in a pane

PAGE UP PAGE UP (extended)

Move right one 
screen in a pane

CTRL+PAGE DOWN CONTROL+PAGE 
DOWN (extended)

Move left one 
screen in a pane

CTRL+PAGE UP CONTROL+PAGE UP 
(extended)



See Also
Editing Keys
Function Keys
Selection Keys



Selection Keys
See Also

Selecting in the Criteria Pane or Data Pane

Note      If you're using a Macintosh, some of the key combinations listed below are 
available only with an extended keyboard.    These combinations are followed by 
"(extended)" in the list.

Select values within a column

To In Windows 
press

On the 
Macintosh 
press

Select (or cancel
selection of) 
current value

F2 F2 (extended)

Select value in 
next column

TAB, RIGHT ARROW,
or ENTER

TAB, RIGHT ARROW, 
or ENTER

Select value 
from insertion 
point to 
beginning of 
column

SHIFT+HOME SHIFT+HOME 
(extended)

Select value 
from insertion 
point to end of 
column

SHIFT+END SHIFT+END 
(extended)

Extend selection

or cancel 
selection of one 
character to the 
right

SHIFT+RIGHT 
ARROW

SHIFT+RIGHT 
ARROW

Extend selection
or cancel 
selection of one 
word to the right

CTRL+SHIFT+RIGH
T ARROW

CONTROL+SHIFT+
RIGHT ARROW 
(extended) or 
COMMAND+SHIFT+
RIGHT ARROW

Extend selection
or cancel 
selection of one 
character to the 
left

SHIFT+LEFT 
ARROW

SHIFT+LEFT ARROW

Extend selection
or cancel 
selection of one 
word to the left 

CTRL+SHIFT+LEFT 
ARROW

CONTROL+SHIFT+
LEFT ARROW 
(extended) or 
COMMAND+SHIFT+L
EFT ARROW

Select a row



To In Windows 
press

On the 
Macintosh 
press

Select current 
row

SHIFT+SPACEBAR SHIFT+SPACEBAR

Select next row 
(if current row is
selected)

DOWN ARROW DOWN ARROW

Select previous 
row 
(if current row is
selected)

UP ARROW UP ARROW

Extend selection
down one 
screen

SHIFT+PAGE DOWN SHIFT+PAGE DOWN 
(extended)

Extend selection

up one screen

SHIFT+PAGE UP SHIFT+PAGE UP 
(extended)

Select entire 
result set

CTRL+SHIFT+
SPACEBAR

CONTROL+SHIFT+
SPACEBAR 
(extended) or 
COMMAND+SHIFT+
SPACEBAR

Select a column

To In Windows 
press

On the 
Macintosh 
press

Select current 
column

CTRL+SPACEBAR CONTROL+SPACEBA
R (extended) or 
COMMAND+SPACEB
AR

Select column 
to the right (if 
current column 
is selected)

RIGHT ARROW RIGHT ARROW

Select column 
to the left (if 
current column 
is selected)

LEFT ARROW LEFT ARROW

Extend 
selection right 
one screen

CTRL+SHIFT+PAG
E DOWN

CONTROL+SHIFT+
PAGE DOWN 
(extended)

Extend 
selection left 
one screen

CTRL+SHIFT+PAG
E UP

CONTROL+SHIFT+
PAGE UP 
(extended)

Select columns and rows using Extend mode



To In Windows 
press

On the 
Macintosh press

Turn Extend 
mode on

F8    (see following
note)

F8 (see following 
note)

Cancel Extend 
mode

ESC ESC (extended) or 
COMMAND+PERIOD

Note      Once Extend mode is on, if the insertion point is in a value in a cell, pressing F8 
repeatedly extends the selection to the word containing the insertion point, and then the 
entire value.    If a row is selected, pressing F8 extends the selection to all records.    Press 
ESC to cancel Extend mode



See Also
Editing Keys
Function Keys
Navigation Keys



Editing Keys
See Also

Editing Within the Criteria Pane or Data Pane

Note    If you're using a Macintosh, some of the key combinations listed below are available 
only with an extended keyboard.    These combinations are followed by "(extended)" in the 
list.

Copy, cut, paste, or delete

To In Windows 
press

On the 
Macintosh press

Copy selection 
onto the 
Clipboard

CTRL+C CONTROL+C 
(extended) or 
COMMAND+C

Paste contents 
of Clipboard at 
the insertion 
point

CTRL+V CONTROL+V 
(extended) or 
COMMAND+V

Cut selection 
and copy it 
onto Clipboard

CTRL+X CONTROL+X 
(extended) or 
COMMAND+X

Delete selection 
or character to 
the left of 
insertion point

BACKSPACE DELETE

Delete selection 
or character to 
the right of the 
insertion point

DEL DEL (extended)

Undo changes

To In Windows 
press

On the 
Macintosh press

Undo typing CTRL+Z or 
ALT+BKSP

CONTROL+Z 
(extended) or 
COMMAND+Z

Undo changes in 
current field or 
current record; if 
both are changed,
press ESC twice
-or-
COMMAND+PERIOD
twice to undo 
changes, first in 
the current field 
and then in the 
current record. 

ESC ESC (extended) or 
COMMAND+PERIOD



To In Windows 
press

On the Macintosh
press

Open the Zoom 
Field dialog box in
the Data pane for
entering values in
small input areas 
more 
conveniently

SHIFT+F2 SHIFT+F2 (extended)



See Also
Function Keys
Navigation Keys
Selection Keys



Query Window
See Also

Use the Query window to create and modify a query's design and display the data the 
query retrieves.
To learn more about the parts of the Query window

Click below in the part of the window you want to learn about, or click the name of 
the part.



Table Pane

Displays the field lists for the tables you add to the query.    The tables contain the 
fields from which you retrieve data.    

To view the data stored in a particular field, add that field to the Data pane.
When there are two or more tables in the Table pane, each table must be connected 

by a join line to another table.
Microsoft Query displays the Table pane when you create a new query.    You can hide 

and redisplay the Table pane by choosing Tables from the View menu or by clicking the View 
Tables button on the toolbar.    



Criteria Pane

Displays the criteria you specify to limit the records Microsoft Query displays in the 
result set in the Data pane.

When you specify criteria using the Add Criteria button or the Add Criteria command, 
Microsoft Query adds the criteria to the Criteria pane.    You can also type criteria into the 
Criteria pane yourself.

Microsoft Query doesn't automatically display the Criteria pane when you create a 
new query; however, it displays the Criteria pane the first time you specify criteria using the 
Add Criteria button or by choosing Add Criteria from the Criteria menu.    You can also display
or hide the Criteria pane by choosing Criteria from the View menu or by clicking the View 
Criteria button on the toolbar.

The Criteria Field row displays the field or fields for which you specify criteria.    
Microsoft Query retrieves only those records whose values in the specified fields meet the 
criteria.      

The Value row displays the expression for the criteria you set.
The "or" row displays alternative criteria the records must meet.    You use a separate 

cell to specify each additional criterion.    



Data Pane

Displays the result set Microsoft Query produces after you add fields from the Table 
pane to the Data pane and run the query.    

You add a field to the Data pane by dragging it from a field list in the Table pane to 
the blank column in the Data pane or by double-clicking its name in the field list. Additional 
methods are described in Chapter 1, "Getting Started with Queries," in the Microsoft Query 
User's Guide.    

Field names appear as column headings.
To view records that don't appear on the screen, use the vertical scroll bar, the PAGE 

UP and PAGE DOWN keys in Microsoft for Windows (in Microsoft Query for the Macintosh, 
available for extended keyboards only), or the navigation buttons.

To view fields that don't appear on the screen, use the horizontal scroll bar or the 
arrow keys.

You can limit the records in a result set by specifying criteria.
Once Microsoft Query displays the data, you can add, edit, or delete records, and you

can change how the data looks.    For example, you can sort data, rearrange the columns, or 
change the display font.
Record Selector Symbols
Microsoft Query displays the following symbols in the record selector along the left edge of 
the result set.    Click a record selector to select an entire record.

Current record
New record
Record edited but not yet saved
Record locked by another user

Note      Click the topmost record selector (on the same line as the column headings) to 
select all the records in the result set.



navigation buttons
The navigation buttons enable you to move among the records in the result set.



See Also
Help:

Keyboard Guide
Toolbar

Cue Cards:
Add, Edit, or Delete Data
An Example of a Query
Change How Data Looks
Create a New Query
Open an Existing Query
View the Criteria Pane

User's Guide:
Chapter 1, "Getting Started with Queries"



split bar
By dragging the split bar up and down, you can resize the panes in the Query window.

If the Table pane and Data pane are displayed, there's one split bar to resize the two 
panes.    

If the Criteria pane is also displayed, there's one split bar above it for resizing the 
Table pane, and one split bar below it for resizing the Criteria pane and Data pane.    





Toolbar
See Also

Toolbar buttons provide shortcuts to choosing menu commands.
To find out more about a toolbar button

Click the button on the toolbar below.



 See Also
Help:

Commands
Query Window

User's Guide:
Chapter 1, "Getting Started with Queries"



Couldn't open file <name>.

Microsoft Query couldn't open or read from the file you're attempting to open, or it couldn't 
save the file.    
Possible causes:

There may be a disk error.
The file may be corrupted.



Text too long; paste canceled.

The text you're attempting to paste from the Clipboard is too long to fit in the selected field
in the Data pane or Criteria pane.    The maximum number of characters you can fit into the
field depends on the length specified for the field when the table was created.



Can't paste.

The Clipboard isn't responding.    Another application may be using it, the data on the 
Clipboard may not be in a format Microsoft Query recognizes, or there may not be enough 
free memory for the paste operation.    Try closing other windows in Microsoft Query or 
closing other applications, or restart Microsoft Windows or your Macintosh, and then copy 
and then paste the data again.

See Also
Cue Cards:

Copy Data to Another Application
Copy or Move Data

User's Guide:
Chapter 3, "Working with Data"



A display driver resolution of at least 400 x 350 pixels is required to run Microsoft 
Query.    (Windows only)

Your video display driver doesn't have enough resolution to run Microsoft Query.    Replace 
the display driver using Microsoft Windows Setup.    You may first need to upgrade your 
computer's video card to one that supports a higher resolution.



Clipboard format not supported.

The data on the Clipboard is in a format that Microsoft Query doesn't recognize.
See Also
Cue Cards:

Copy Data to Another Application
Copy or Move Data

User's Guide:
Chapter 3, "Working with Data"



Couldn't open Clipboard.

The Clipboard isn't responding, probably because another application is using it.    Close 
that application and try the operation again.

See Also
Cue Cards:

Copy Data to Another Application
Copy or Move Data

User's Guide:
Chapter 3, "Working with Data"



Data format error; can't paste.

Microsoft Query can't paste the data from the Clipboard.    There may not be enough free 
memory.    Try closing other windows in Microsoft Query or closing other applications, or 
restart Microsoft Windows or your Macintosh, and then copy and then paste the data again.



Not enough system resources to update display.

There isn't enough free memory to complete the operation.    Close windows in Microsoft 
Query, close other applications, or restart Microsoft Windows or your Macintosh, and then 
try the operation again.



Incompatible version of <filename>; Microsoft Query can't run.    (Windows only)

The DDEML.DLL file is either outdated or missing.    Try reinstalling Microsoft Query or 
Microsoft Windows.



Unable to quit Microsoft Query.

Microsoft Query is communicating with another application through DDE.    Wait for the DDE
action to finish, and then quit Microsoft Query.    



Can't start Microsoft Query.    Please try again.

A system error occurred, or there isn't enough free memory to start Microsoft Query.    Start 
Microsoft Query again, close other applications, or restart Microsoft Windows or your 
Macintosh.



Outdated <filename> file.    Please reinstall Microsoft Query.

Your installation of Microsoft Query is incomplete or corrupted.    Run Setup to reinstall.



Value must be a number.

You entered a value that isn't a number for an option setting that requires a numeric value. 
Enter a number instead.



Number is too large.

Enter a smaller value.



Not a recognized unit of measurement.

Microsoft Query doesn't recognize the characters you typed for this option setting.    Enter a
number for the measurement, but don't include characters for the type of units, such as " 
or "in" (for inches) or cm (for centimeters).



Save changes to Query <name>?

You've made changes to the design or format of the current query since you last saved it.    
Choose Yes to save your changes before closing the query.
Choose No to discard the changes and close the query.
Choose Cancel to keep the query open without saving the changes.

See Also
Help:

Save As Command (File Menu)
Cue Cards:

Save a Query
User's Guide:

Chapter 1, "Getting Started with Queries"



Can't undo this operation.    Continue anyway?

The Undo command isn't available for this operation because the operation is too large or 
there isn't enough free memory.    

Choose OK to continue the operation without the possibility of undoing it.
Choose Cancel to discontinue the operation.



Can't open DDE channel; Microsoft Query couldn't find the specified application 
and topic.

Check to make sure:
The other (destination) application is running.
The topic (the subject of the DDE conversation) is open.
You have spelled the name of the application and topic correctly in defining the DDE 

conversation.
See Also
Help:

DDE Commands
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



DDE conversation closed or changed.

The other application has closed or changed the DDE conversation unexpectedly, possibly 
by issuing a DDETerminate or DDETerminateAll statement.    Terminate this 
conversation, and establish a new conversation with the other application.

See Also
Help:

DDE Commands
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Message queue filled; DDE message lost.

Microsoft Query couldn't keep up with the number of DDE operations attempted.
There may be too many DDE conversations going.    Terminate some DDE conversations.

See Also
Help:

DDE Commands
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



The other application is busy.

The other application in the DDE conversation is busy and couldn't perform a DDE 
operation.    Wait until the other application is free.

See Also
Help:

DDE Commands
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



The other application quit.

The other application in the DDE conversation quit unexpectedly.    Restart the other 
application before reinitiating the DDE conversation.

See Also
Help:

DDE Commands
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



The other application won't perform the DDE operation you attempted.

The other application couldn't perform the DDE operation you attempted.
Possible causes:

You supplied data or commands that the other application did not recognize.    Check 
the application's documentation to see what data or commands it recognizes.

Based on the defined topic of the conversation, the other application doesn't 
recognize the item argument.    Check the application's documentation to see what items it 
recognizes.
See Also
Help:

DDE Commands
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



The DDE transaction failed.    Check to ensure you have the correct version of 
DDEML.DLL.

Your installation of Microsoft Query is incomplete or corrupt.    Run the Setup program to 
reinstall.



Timeout while waiting for DDE response.

The other application in the DDE conversation didn't respond in the time specified by the 
DDE Timeout option.
Possible causes:

The other application is waiting for a response from the user.    Switch to that 
application, and close the dialog box; or take an action appropriate to the message it is 
displaying.

The other application is too busy to respond to DDE messages.    
Note    You can't change the time specified in the Timeout option.



Between operator without And.

You must enter the reserved word And when you use the Between...And operator.    The 
syntax is:
expression Between value1 And value2



Expression too complex.

You've used an expression that is too complex to be successfully evaluated.    Try to simplify
the expression.

See Also
Help:

Expressions Overview
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Extra ')'.

You've used an expression that has too many closing parentheses.    Delete any parenthesis
that doesn't have a matching opening parenthesis.

See Also
Help:

Expressions Overview
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Invalid use of '.', '!', or '( )'.

You've used an expression that has an invalid . (dot) or ! operator or invalid parentheses.    
For example, you may have entered an invalid identifier or typed a parenthesis following 
the constant Null.    Check the expression to make sure you entered it correctly.

See Also
Help:

Expressions Overview
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Missing ')', ']', or '|'.

You've used an expression that is missing a closing parenthesis, bracket, or vertical bar.    
Check the expression to make sure you entered it correctly.

See Also
Help:

Expressions Overview
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Out of memory during calculation.

Not enough memory available to perform calculation.    Close windows in Microsoft Query, 
close other applications, or restart Microsoft Windows or your Macintosh; then retry the 
calculation.



Syntax error in date.

You've used an expression that has an invalid date value.    Check the expression to make 
sure you entered it correctly.

See Also
Help:

Expressions Overview
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Syntax error in number.

You've used an expression that has an invalid number.    Check the expression to make sure 
you entered it correctly.

See Also
Help:

Expressions Overview
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Syntax error in string.

You've used an expression that has an invalid string.    For example, you may have 
exceeded the maximum length of a string.    Check the expression to make sure you 
entered it correctly.

See Also
Help:

Expressions Overview
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Syntax error.

You've used an expression that has invalid syntax.    For example, you may not have 
entered an operand or operator, you may have entered an invalid character or comma, or 
you may have entered text without surrounding it in quotation marks (" or ' ).    

See Also
Help:

Expressions Overview
User's Guide:

Chapter 4, "Retrieving the Records You Want"



 Couldn't add the table <name>.

Possible causes:
The specified table doesn't exist.
You've misspelled the table name.    Check for missing underscores    ( _ ) or other 

punctuation.
The specified table contains no valid fields (columns).



Syntax error in GROUP BY clause.

SQL statement has an invalid GROUP BY clause.
Possible causes:

A reserved word is misspelled or missing.
Punctuation is incorrect.



Syntax error in ORDER BY clause.

SQL statement has an invalid ORDER BY clause.
Possible causes:

A reserved word is misspelled or missing.
Punctuation is incorrect.



Syntax error in HAVING clause.

SQL statement has an invalid HAVING clause.
Possible causes:

A reserved word is misspelled or missing.
Punctuation is incorrect.



Syntax error in JOIN expression.

ON clause in SQL statement isn't followed by a valid expression.    The expression should be
in the following format:
{oj C:\QT\orders orders LEFT OUTER JOIN C:\QT\orddtail orddtail ON orders.ORDER_ID = 
orddtail.ORDER_ID}



Incorrect column expression:    <expression>.

The expression you've specified in the Select list isn't correct.    The expression should be in 
the following format:
SELECT employee.EMPLOY_ID, employee.HIRE_DATE
FROM C:\QT\employee employee



Expected 'BY' after 'GROUP'.

SQL statement includes a GROUP clause instead of a GROUP BY clause.    BY is either 
misspelled or missing.



Expected 'BY' after 'ORDER'.

SQL statement includes an ORDER clause instead of an ORDER BY clause.    BY is either 
misspelled or missing.



Expected expression after 'WHERE'.

WHERE clause in SQL statement isn't followed by a search condition.



Expected expression after 'HAVING'.

HAVING clause in SQL statement isn't followed by a search condition.



Expected HAVING expression.

Clause and expression in SQL statement must be followed by a HAVING clause and 
expression. 



Expected 'JOIN' after 'OUTER'.

SQL statement includes a LEFT OUTER or RIGHT OUTER clause instead of a LEFT OUTER 
JOIN or RIGHT OUTER JOIN clause.    JOIN is either misspelled or missing.



Expected 'ON' after right join table.

SQL statement includes a LEFT OUTER JOIN or RIGHT OUTER JOIN clause and its expression,
but the expression isn't followed by ON clause and its expression.    ON is either misspelled 
or missing.



Expected table name after FROM.

SQL statement includes a FROM clause that isn't followed by a table name.    



Didn't expect <text> after the column list in the GROUP BY clause.

Expression or clause after the column list in the GROUP BY clause isn't valid.    



Didn't expect <text> after the HAVING clause.

Expression or clause after the HAVING clause in the SQL statement isn't valid. 



Didn't expect <text> after the column list in the ORDER BY clause.

Expression or clause after the ORDER BY clause in the SQL statement isn't valid.



Didn't expect <text> after the select list in the SELECT statement.

Expression or clause after the select list in the SELECT statement isn't valid.      



Expected join operator after table <name>.

LEFT OUTER JOIN or RIGHT OUTER JOIN clause is missing the = operator between the two 
table names in the expression.    Outer joins must be equi-joins.    



Left and right outer joins must be equi-joins.

LEFT OUTER JOIN or RIGHT OUTER JOIN clause either omits the = operator between the two
table names in the expression or uses a different operator.    Outer joins must be equi-joins.  



Expected 'OUTER' after LEFT/RIGHT.

SQL statement includes a LEFT or RIGHT outer join clause that's missing the keyword 
OUTER.    An outer join clause in the SQL statement must be either a LEFT OUTER JOIN or 
RIGHT OUTER JOIN.    



Didn't expect <text> after the WHERE clause.

Expression or clause after the WHERE clause in the SQL statement isn't valid. 



Expected 'oj' after '{'.

After a FROM clause, an outer join expression is missing 'oj' after the opening bracket.    



Expected LEFT or RIGHT after table <name>.

SQL statement includes an OUTER JOIN clause, but isn't preceded by the keywords LEFT or 
RIGHT.    An outer join clause in an SQL statement must be either a LEFT OUTER JOIN or 
RIGHT OUTER JOIN clause.    



Expected expression after 'ORDER BY'.

SQL statement includes ORDER BY but isn't followed by an expression. 



Expected expression after 'GROUP BY'.

SQL statement includes GROUP BY but isn't followed by an expression.    



Can't display the criterion.

Microsoft Query is unable to display the criterion you've specified because it's invalid.    



Can't set criteria unless you've specified a field.

Before you can specify criteria for a field, you must add that field to the Criteria pane.
See Also
Cue Cards:

Specify Criteria
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Can't apply aggregates to tables.

You've typed an asterisk (*) for the Field option instead of specifying a specific field on 
which you want to calculate a total.    Remove the * and select or type the field name. 



Expression too long for the QBE grid and has been truncated.

Microsoft Query truncated the expression you've specified because it's too long to evaluate.



Expression too long.

The expression is too long for Microsoft Query to evaluate. 



Application is corrupted.

The Microsoft Query application is corrupted.    Reinstall Microsoft Query and try the 
operation again; or, contact your distributor for a new copy of Microsoft Query.



Record doesn't exist.

The record number you specified does not exist.    The record number you've specified may 
be too large or too small.    Make sure there are records in the Data pane, and then verify 
that you've entered the record number correctly.



Help isn't available due to lack of available memory or improper installation of 
Windows or Microsoft Query.

Try closing windows or other applications to free some memory.    If necessary, reinstall 
Microsoft Windows or Microsoft Query.



<Number> records will be updated.

The Data pane contains other records that match the record you've revised.    As a result, 
Microsoft Query will automatically update the matching records with the same changes.    

To avoid duplicate records in the Data pane, you should add all fields to the Data 
pane before you make changes to your data.    

Choose OK to update the records.
Choose Cancel to prevent updating any records.    

See Also
Cue Cards:

Add, Edit, or Delete Data
User's Guide:

Chapter 3, "Working with Data"



Delete <number> record(s).

You've indicated that you want to delete this number of records.    

Note    If the number of records is greater than you've specified, it's because Microsoft 
Query found duplicate records based on the fields in the Data pane.    To avoid duplicate 
records, you should add all fields to the Data pane before you delete any records. 

Choose OK to delete the records.
Choose Cancel to prevent the deletion.

See Also
Cue Cards:

Add, Edit, or Delete Data
User's Guide:

Chapter 3, "Working with Data"



Must have two instances of the table to create a self-join.

You have two different tables in the Table pane and have defined a self-join by using the 
same table name in the Left and Right boxes in the Joins dialog box. 
To create a self-join, you need two instances of the same table in the Table pane.    
To join two different tables, you must use one of the tables for the left side of the join and 
the other table for the right side of the join.    

See Also
Help:

Create a Self-Join
Cue Cards:

Join Tables
User's Guide:

Chapter 6, "Creating Multiple-Table Queries"



Can't specify * as a field.    To add all fields, drag and drop * into the grid.

You typed an asterisk (*) in the Field cell in the Criteria pane.    Instead, to specify criteria for
all fields in the query, use one of these methods:    

Drag the * from the field list to the Criteria pane.
Double-click the asterisk in the field list.
Add each field individually.

See Also
Cue Cards:

Add All Fields
User's Guide: 

Chapter 1, "Getting Started with Queries"



Columns <name> and <name> that you are about to join are of different types.    
Create the join anyway?

You're joining fields (columns) that contain different data types.    For example, you may be 
joining a field containing dates with a field containing text.    
Choose OK to create the join.    

Note    This type of join may not produce the results you want.    Check the data Microsoft 
Query displays in the result set.
Choose Cancel to prevent the join.      

See Also
Cue Cards:

Join Tables
User's Guide:

Chapter 6, "Creating Multiple-Table Queries"



Function <name> can't be used with <column name>.

You've selected a function that can't be calculated for the type of data in this field.    For 
example, because it contains text, you can't calculate the average of the SHIP_CNTRY field.

See Also
Cue Cards:

Calculate Totals
Different Types of Totals
How Totals Work

User's Guide:
Chapter 5, "Performing Calculations on Data"



Can't access table <name>.

Possible causes:
The specified table can't be found.
The specified table is locked by another user or by another query being run by you.
There are no valid fields in specified table.



Executed SQL statement successfully.

Microsoft Query has successfully executed the SQL statement you've specified.    No rows 
(records) have been updated or deleted.



Refresh failed.

Microsoft Query is unable to update the list of tables in the Add Tables dialog box because 
the data source doesn't respond.    Check to see if you're still connected to the data source. 



Executed SQL statement successfully: <number> rows affected.

Microsoft Query has executed the SQL statement you've specified, affecting the number of 
rows (records) indicated.



Can't create an empty table.

You've tried to save an empty result set as a table.    You must add fields to the Data pane 
before you can save the result set as a table.

See Also
Help:

Save a Query's Result Set as a Table
User's Guide:

Chapter 7, "Creating and Deleting Tables"



I/O error during save.

Microsoft Query is unable to save the query to disk.    There may be a disk error.



I/O error during load.

Microsoft Query is unable to open or read the file you've selected.    There may be a disk 
error or the file may be corrupted. 



Couldn't create new window.

Microsoft Query can't display the file you've selected, possibly because there isn't enough 
memory.    Close other windows in Microsoft Query, close other applications, or restart 
Windows or your Macintosh.



Not all functions supported by driver.

The expression you just entered contains one or more functions that your data source 
doesn't support.    To determine what functions it supports, see the documentation that 
comes with the driver your data source uses, or contact the driver vendor.    (In Microsoft 
Query for Windows, check the ODBC Drivers item in the Microsoft Query Help Contents to 
see if your driver is listed.)



Too many values selected.

There isn't enough memory to store all the values you've specified as criteria for this field.   
Specify fewer values.



Can't open multiple copies of a file.

You can't have two copies of a query file open at the same time.



Save stopped due to invalid query state.

The query design isn't valid.    For example, you may not have specified criteria correctly.    If
Automatic Query is off, try running the query by choosing Query Now from the Records 
menu or by clicking the Query Now button on the toolbar to identify the problem.



Stop the save?

You've interrupted the Save operation. 
Choose OK to confirm stopping the operation.    (Microsoft Query may have already 

saved part of the result set to a new table.)
Choose Cancel to continue saving.



Couldn't open file.

Microsoft Query is unable to open or read the Microsoft Query file you've specified from the 
Execute SQL dialog box.    The file may not be in text format, there may be a disk error, or 
the file may be corrupted.



Can't create file.

Microsoft Query is unable to create the query file you specified.    There may be a disk error 
or the file may be corrupted.



Can't save the column <name> to this data source.

You're trying to save a result set as a table, but the data source you're saving it to doesn't 
support the data type assigned to the specified field or can't convert it to a comparable 
data type.    Try saving to another data source that does support the data type.



Can't open file.

Microsoft Query is unable to open the Q+E file you specified.    There may be a disk error or 
the file may be corrupted.



Error during save operation.

Microsoft Query was unable to save one or more of the rows (records) in the result set to 
the new table.



Unable to execute query.    View SQL text?

Microsoft Query is unable to execute the SQL statement because it refers to an item that is 
currently invalid.    For example, it may refer to a table that no longer exists.    Choose OK to 
view the SQL statement and make the necessary changes.



General ODBC Error

Microsoft ODBC or your data source has returned an error with no detailed information 
available.



Driver error.

This error was returned by the driver.    For more information, check the documentation for 
the driver you are currently using.



Invalid table name.

The table name is blank or doesn't follow the standard naming conventions your data 
source requires.    See the documentation for your data source.



File name isn't valid.

File names must follow the standard naming conventions your data source requires.    See 
the documentation for your data source.



Can't add expression <name> to the sort list.

The data source you're using doesn't allow you to sort on a field that displays the results of 
an expression.



<Value> exceeds the numerical range of this column.

Value exceeds the maximum number allowed for values in this column (field).    Enter a 
smaller value. 



<Value> has too many digits after the decimal.

There are more digits after the decimal than are allowed for values in this field.    Use fewer 
digits.



<Value> isn't a valid number.

You've entered the wrong type of value in the field.    For example, you may have entered 
text in a field that accepts only numbers.



<Value> isn't a Boolean value.

You've entered a non-Boolean value in a field that accepts only Boolean values.    For 
example, you may have entered a date when the field accepts only a value of "0" or "1." 



<Value> isn't a valid date.

You've entered the wrong type of value in the field.    For example, you may have entered 
text in a field that accepts only dates.    



Can't edit multiple-table query.

You can't edit data in a query that contains more than one table.    
To edit data in a table, add only that table to the query, and then choose Allow Editing from 
the Records menu.    
To edit data in the current query, delete the extra table(s) from the query, keeping only the 
table that contains the data you want to edit.    Choose Allow Editing from the Records 
menu.    

Note    When you delete a table in a query, you're not deleting the data in the underlying 
table; you're just deleting the table and its data from the current query.



Couldn't remove data source.

Microsoft Query is unable to remove the data source you selected.    You may be 
disconnected from the data source.



Couldn't add data source

Microsoft Query is unable to add the data source you selected.    There is a problem 
connecting to the data source.



Can't remove; some queries are using this source.

One or more queries are using the data source you're trying to remove.    If you want to 
remove the data source, first close the queries that are using it. 



Table <name> already exists; replace it?

A table with the name you've just entered already exists.    
Choose Yes to replace the previous table with the one you're creating.
Choose No to prevent overwriting the previous table, and then enter a different name

for the new table.



Error in the name <name>.

The table name and field names must follow the standard naming conventions your data 
source requires.    See the documentation for your data source.



Maximum length for type <data type name> is <number>.

You've entered a number in the Length box that exceeds the maximum length allowed for a
field with this data type.

See Also
Help:

Create a New Table
User's Guide:

Chapter 7, "Creating and Deleting Tables"



Number of digits after the decimal should be less than or equal to the total 
length.

You've entered a number in the Decimal box that is greater than the number in the Length 
box.    Change the value in the Decimal box to a number that is less than or equal to the 
number in the Length box. 

See Also
Help:

Create a New Table
User's Guide:

Chapter 7, "Creating and Deleting Tables"



Length <number> must be numeric.

You've used a value in the Length box that isn't numeric.    Change the value to a number.



Table <name> was created successfully.

Microsoft Query created the table you defined using the data source you selected.



Delete table <name>?

You've indicated that you want to delete this table.    If you delete the table, you delete all 
the data in it.

Note    Once you delete the table, you can't undo the deletion.
Choose the Yes button to delete the table and the data stored in it.
Choose the No button to prevent the deletion.

See Also
Help:

Delete a Table
User's Guide:

Chapter 7, "Creating and Deleting Tables"



Table <name> was deleted successfully.

Microsoft Query deleted the table and all the data stored in it.    You can't undo this deletion.



SQL execution failed.

Microsoft Query can't execute the SQL statement you've specified.    Check the statement 
to make sure you've entered it correctly.



Couldn't fetch procedures.

Microsoft Query can't display the list of procedures from data source because the data 
source isn't responding.    You may be disconnected from the data source. 



Couldn't read this file.

Microsoft Query is unable to read this file.    The file may not be in Microsoft Query or Q+E 
format, there may be a disk error, or the file may be corrupted.



First select a data source.

You tried to execute an SQL statement before selecting a data source.    Choose the Data 
Sources button in the Execute SQL dialog box, and then select a data source.

See Also
Help:

Create a Query Using a Custom SQL Statement
Execute Procedures

User's Guide:
Chapter 8, "Working with SQL" 



No procedures found.

This data source doesn't contain any procedures.    To create procedures, refer to the 
documentation for your data source.



Can't save to a file that is already open.

The file you're trying to save to is open.    Close the file before trying to save to it again.



Table <name> already in the query; add it again?

You're trying to add a table that's already in the Table pane.    Choose OK to add the table if 
you want to create a self-join; or choose Cancel to prevent the table from being added.

See Also
Help:

Create a Self-Join
User's Guide:

Chapter 6, "Creating Multiple-Table Queries"



Couldn't find the ODBC administrator; reinstall ODBC.

The specified utility can't be located.    Reinstall ODBC and try the operation again.



Couldn't find Cue Cards; reinstall Microsoft Query.

Cue Cards can't be located; therefore, they aren't available.    Reinstall Microsoft Query and 
try the operation again.



Save failed:    not enough connections available.

You're trying to save a result set as a table to a data source that doesn't have any 
connections available.    If you have multiple connections to the data source, try removing 
one; otherwise, wait until a connection becomes available before trying to use this data 
source again.



Can't edit grouped query.

You can't edit data in a query that contains totals or that has the Group Records check box 
selected in the Query Properties dialog box.    To edit the data, remove the totals or cancel 
selection of the Group Records property.



Unable to retrieve values.

Microsoft Query is unable to display the values you've selected for criteria.    There may not 
be enough memory or you may be disconnected from the data source.    If you're still 
connected to the data source, try closing other windows in Microsoft Query, closing other 
applications, or restarting Microsoft Windows or your Macintosh.



Couldn't create index.

The data source for this table doesn't support indexes.    



Length specified must be greater than 0.

The length specified in the Length box in the Table Definition dialog box must be greater 
than 0.



Some queries are using <connection name>; close anyway?

One or more queries are using the data source you're trying to remove.    
Choose OK to remove the data source and close the queries.
Choose Cancel to keep the data source in the list and the query open.



Remote links exist; close anyway?

The data in your query is linked to another application (such as Microsoft Excel or Microsoft 
Word).    

Choose the OK button to close the query and the link.    (You can't reestablish the link 
once you close the query).

Choose the Cancel button to keep the query open and the link established.



Width must be between 0 and <number>.

Specify a column width between these two numbers, or select the Standard Width option in
the Column Width dialog box.



Height must be between 1 and <number>.

Specify a row height between these two numbers, or select the Standard Height option in 
the Row Height dialog box.



Save large Clipboard from <name>.

You've placed a large amount of data on the Clipboard.    
Choose Yes to save the data on the Clipboard and close the query, or quit Microsoft 

Query.
Choose No to delete the data and close the query, or quit Microsoft Query.
Choose Cancel to continue working in Microsoft Query with the data still on the 

Clipboard. 



Update failed.    Continue editing record?

Microsoft Query can't update the data you've just edited.
Possible causes:

The underlying table or data source is read-only.
The underlying table is corrupted.
There isn't enough disk space to store the changes.



Can't edit a calculated column.

You can't edit data in a column on which you've calculated totals or that displays the results
of a custom expression.



Only two tables are allowed with an outer join.    Delete outer join to add table?

You already have two tables in the Table pane connected with an outer join.    If you want to 
use three or more tables in the Table pane, you must delete the outer join or change it to 
an inner join.

See Also
Cue Cards:

Change Join Type
Join Tables

User's Guide:
Chapter 6, "Creating Multiple-Table Queries"



Query can have only one outer join.

You can have only one outer join in a query.



Can't have outer joins if there are more than two tables in the query.

You can have only two tables in the Table pane when you use an outer join.    Remove the 
extra tables from the Table pane, and then create the outer join.

See Also
Cue Cards:

Change Join Type
User's Guide:

Chapter 6, "Creating Multiple-Table Queries"



SQL Query can't be represented graphically.    Continue anyway?

Microsoft Query can't display the Table pane for this query.    If the query returns records, 
you can't edit them or the query's design in the Query window.    However, you can edit the 
query's design by choosing SQL from the View menu and editing the SQL statement 
directly.

See Also
Help:

Create a Query Using a Custom SQL Statement
User's Guide:

Chapter 8, "Working with SQL"



Must select one value for the operator <operator>.

When you define criteria with this operator, you must use only one value.    Microsoft Query 
then selects only the records containing this value in the field on which you set the criteria. 
For example, if you select "begins with" in the Operator box, Microsoft Query searches the 
field on which you set the criteria for values that begin with the value you specify.    It then 
selects only those records for the result set.

See Also
Cue Cards:

Specify Criteria
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Must select two values for the operator <operator>.

When you define criteria with this operator, you must use two values.    For example, if you 
select "is between" in the Operator box, Microsoft Query searches the field on which you 
set the criteria for values that fall between the two values you specify.    It then selects only 
those records for the result set.

See Also
Cue Cards:

Specify Criteria
User's Guide:

Chapter 4, "Retrieving the Records You Want"



Column <name> can't be used in the criteria.

You can't specify criteria on a column (field) with this data type.      



Column <name> can't be used with the operator <operator>.

Your data source doesn't allow this field to be used with the operator you've specified 
because of the field's data type.    Refer to the documentation for your data source to see 
which operators you can use with fields of this data type.



Incorrect extension <extension>.

The table name you've specified does not contain a valid file extension.    Refer to the 
documentation for your data source for the correct extension.



Existing tables can't be modified.    Changes can be used to create a new empty 
table.

To create a new table from an existing table, you must change the table name in the View 
Table Definition dialog box.    (The new table doesn't contain the data stored in the existing 
table.) You can't edit existing table definitions in Microsoft Query.



Can't find record.    More columns are needed to identify it, or another user may 
have modified it.

Microsoft Query can't find a record in the underlying table that matches the record you've 
updated or deleted in the query.    You may not have enough columns in the query to 
distinguish the record you're trying to update, or another user may have changed the 
record since the last time you ran the query.    Before you update the record, do one of the 
following: 

Add more columns to the query, or add the column that uniquely identifies the 
record. 

Choose Query Now from the Records menu (or click the Query Now button on the 
toolbar) to rerun the query to get the most current data from the underlying table. 



Save file as <name>.

You're trying to save a result set as a table with a file name whose extension is either 
incorrect or missing.    

Choose OK to save the result set to a file with the correct extension for your data 
source.

Choose Cancel to return to Microsoft Query without saving the result set.
See Also
Help:

Save a Query's Result Set as a Table
User's Guide:

Chapter 7, "Creating and Deleting Tables"



Nonunique record found.

There are identical records in the result set because the Data pane doesn't include a field 
whose values uniquely identify each record, such as a customer ID or order ID.    Any 
changes to one of these identical records affects all the identical records.    
To distinguish records, it's a good idea to add all the fields from the underlying table to the 
Data pane before you begin editing data.    

See Also
User's Guide:

Chapter 3, "Working with Data"



Since the database is read-only, you can't create or remove tables.    Continue?

You can view a table definition in a database that's read-only, but you can't create new or 
delete existing tables.



Index was created successfully.

Microsoft Query successfully created the index on the specified field or fields in the table. 



Failed to create unique index.    Create one    yourself?

The result set you're trying to save as a new table came from a table containing a unique 
index, but Microsoft Query was unable to create the unique index for the new table.    
Choose Yes to display the Create Index Dialog Box where you can create a uniqe index for 
the table.
Choose No if you don't want to create a unique index.    



No unique indexes exist in this table.    Create one yourself?

The result set you're trying to save as a new table came from a table that doesn't contain a
unique index.
Choose Yes to display the Create Index Dialog Box where you can create a unique index for 
the table.
Choose No if you don't want to create an index.    



Couldn't access <database>.

The data source you're using allows you to add tables from the current database (or 
database equivalent) only.    



<Number> records match the selection.    Delete them all?

Because the Data pane doesn't include a field whose values uniquely identify each record, 
such as a customer ID or order ID, the result set contains other records that match the one 
you're trying to delete.    If you delete the selected record, Microsoft Query will also delete 
any identical records.    
To distinguish records before you begin editing data, it's a good idea to add all the fields 
from the underlying table or to create a unique index on the table.    

See Also
User's Guide:

Chapter 3, "Working with Data"



Need System 6.0.5 or higher to run.

To run Microsoft Query for the Macintosh, you need the Macintosh Operating System 6.0.5 
or higher.



Unable to display Help.

Possible causes:
Microsoft Query could not find Microsoft Help in the following locations:

System Folder:Extensions:Microsoft:Help, or in the current folder.    Try moving or copying 
Microsoft Help to one of these locations.

The Microsoft Query Help file is not in the current folder.    Try moving or copying the 
file to the current folder.



Microsoft Query Help Contents
Overview

Understanding Queries
What Is a Query? (Cue Card)
Why Use Queries? (Cue Card)

Sample Data and Example 
Query
The Northwind Data (Cue Card)
An Example of a Query (Cue Card)

Creating and Using Queries
Create a Query
Open, Run, Close, and Save a 
Query
Modify a Query's Design
Work With Data
Create and Delete Tables
Work with SQL

Reference
Commands
DDE Commands
Definitions
Keyboard Guide

ODBC Drivers
Query Window
Toolbar



Overview
Procedures for performing tasks in Microsoft Query are described in Cue Cards and Help.    
Cue Cards is an online coach that walks you through the most common Microsoft Query 
tasks as you work with your own data.    Cue Cards includes conceptual information, such as
what a query is, and gives step-by-step instruction on the most common query tasks.    If a 
topic is covered in a Cue Card, the topic title is followed by (Cue Card).
Help offers instruction on more advanced topics.    If a topic is covered in Help, the topic 
title is followed by (Help).    
If you see an item with a solid or dotted underline in the Help Contents and it's not followed
by either (Help) or (Cue Card), it's the title of a category or subcategory of a set of topics. 
Click the category to see the set of topics.
When you click a Cue Cards topic in the Microsoft Query Help Contents, the cue card is 
displayed on top of the Query window.    The Microsoft Query Help Contents window is 
behind the Query window.
To redisplay the Microsoft Query Help Contents window, do one of the following

Press CTRL+ESC, and then select Microsoft Query Help in the Windows Task List.
If the Help window is visible behind the Microsoft Query window, click the Help 

window.
From the Help menu in Microsoft Query, choose Contents.



Create a Query
Create a Query and Choose a Data Source 
Work with Tables
Add Fields
Set Criteria



Open, Run, Close, and Save a Query
Open an Existing Query (Cue Card)
Choose a Data Source (Cue Card)
Your Data Source Isn't Listed (Cue Card)
Adding Data Sources for Installed Drivers (Help)
Run a Query (Cue Card)
Save a Query (Cue Card)
Close a Query (Cue Card)



Create a Query and Choose a Data Source
Create a New Query (Cue Card)
Choose a Data Source (Cue Card)
Your Data Source Isn't Listed (Cue Card)
Add Data Sources for Installed Drivers (Help)



Work with Tables
What is a Table? (Cue Card)
Which Tables Should I Add? (Cue Card)
Add a Table (Cue Card)
Join Tables (Cue Card)
How Joins Work (Cue Card)
Create a Self-Join (Help)
Change Join Type (Cue Card)
Create a Join Not Based on Equality (Help)



Add Fields
Add Fields {overview} (Cue Card)
Add a Field (Cue Card)
Add All Fields (Cue Card)
Add a Calculated Field (Cue Card)



Set Criteria
Retrieve Records (Cue Card)
Specify Criteria    (Cue Card)
Multiple Criteria for a Field (Cue Card)
View the Criteria Pane (Cue Card)
Retrieve Values to Total (Cue Card)
Criteria Expressions {examples} (Cue Card)
Multiple Criteria {examples} (Cue Card)
Expressions Overview (Help)



Modify a Query's Design
Tables
Fields/Columns
Criteria



Tables
Add a Table (Cue Card)
Remove a Table (Cue Card)
Join Tables    (Cue Card)
How Joins Work (Cue Card)
Change Join Type (Cue Card)
Delete a Join (Cue Card)
Create a Self-Join (Help)
Create a Join Not Based on Equality (Help)



Fields/Columns
Add a Field (Cue Card)
Add a Calculated Field (Cue Card)
Remove a Column of Data (Cue Card)
Change Column Headings (Cue Card)
Change Column Width {manually} (Cue Card)
Change Column Width to Best Fit {automatically} (Cue Card)
Move Columns in the Data Pane (Cue Card)
Hide Columns (Cue Card)
Show Hidden Columns (Cue Card)
Change Row Height (Cue Card)
Change the Font (Cue Card)



Criteria
Retrieve Records (Cue Card)
Retrieve Values to Total (Cue Card)
View the Criteria Pane (Cue Card)
Specify Criteria (Cue Card)
Criteria Expressions {examples} (Cue Card)
Expressions Overview (Help)
Multiple Criteria for a Field (Cue Card)
Multiple Criteria {examples} (Cue Card)
Delete a Cell of Criteria (Cue Card)
Delete a Column of Criteria (Cue Card)



Work with Data
Navigate in a Query
Add, Edit, or Delete Data 
Change How Data Looks    
Copy or Move Data
Save Data
Perform Calculations on Data



Navigate in a Query
Move to a Field (Cue Card)
Move to a Record (Cue Card)
Keyboard Methods for Navigating (Cue Card)



Add, Edit, or Delete Data 
Add, Edit, or Delete Data (Cue Card)
Values You Can't Enter (Cue Card)
Fields You Can't Edit (Cue Card)
Select Data (Cue Card)
Undo Changes to Data (Cue Card)



Change How Data Looks
Move Columns in the Data Pane (Cue Card)
Change Column Headings (Cue Card)
Change Column Width {manually} (Cue Card)
Change Column Width to Best Fit {automatically} (Cue Card)
Hide Columns (Cue Card)
Show Hidden Columns (Cue Card)
Change Row Height (Cue Card)
Change the Font (Cue Card)
Sort Records (Cue Card)
Remove a Sort (Cue Card)
Hide Duplicate Data (Cue Card)



Copy or Move Data
Copy or Move Data in a Cell (Cue Card)
Select Data (Cue Card)
Copy Data to Another Application (Cue Card)



Save Data
Save Your Data (Cue Card)
Save a Query's Result Set as a Table (Help)



Perform Calculations on Data
Different Types of Totals (Cue Card)
How Totals Work (Cue Card)
Calculate Totals (Cue Card)
Retrieve Values to Total (Cue Card)
Use Your Own Expressions to Perform Calculations (Help)
Display the Same Total for Each Record in a Group (Help)
Remove a Total (Cue Card)



Create and Delete Tables
Create a New Table (Help)
Delete a Table (Help)
Save a Query's Result Set as a Table (Help)



Work with SQL
View or Edit an Existing Query's SQL SELECT Statement (Help)
Create a Query Using a Custom SQL Statement (Help)
Execute Procedures (Help)



Commands

Control Menu Table Menu
File Menu Criteria Menu
Edit Menu Records Menu
View Menu Window Menu
Format Menu Help Menu



Control Menu
Restore
Move
Size
Minimize
Maximize
Close
Next
Switch To



File Menu
New Query
Open Query
Close Query
Save Query
Save As
Table Definition
Execute SQL
Exit (Windows)
Quit (Macintosh)



Edit Menu
Undo
Cut
Copy
Copy Special
Paste
Delete



View Menu
Tables
Criteria
Zoom Field
Query Properties
SQL



Format Menu
Font
Row Height
Column Width
Hide Columns
Show Columns



Table Menu
Add Tables
Remove Table
Joins



Criteria Menu
Add Criteria
Remove All Criteria



Records Menu
Add Column
Insert Column
Remove Column
Edit Column 
Sort 
Go To
Allow Editing
Query Now
Automatic Query



Window Menu
Tile
Cascade
1,2,3, . . . 9



Help Menu 
Contents
Search
Cue Cards
About Microsoft Query



Definitions
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A-B
active cell argument
Add Criteria button Automatic Query 

button
Add Tables Button Avg
additional (And) 
criteria

Best Fit button

alternative (Or) 
criteria

Boolean

API buffer



application

C
calculated field connection
catalog constant
catalog stored 
procedure

Count

cell criteria
Clipboard Criteria pane
column Cue Cards
column heading current record
comparison operator cursor

D
data DDE channel
data dictionary DDE conversation
Data pane DDE topic
data source DDL
Data Sources button destination 

application
data type destination document
database DLL
DBMS DML
DDE dynamic data

E-K
empty field function
empty string grouping level
equi-join Help button
expression identifier
extension inner join
field input argument
field list ISAM
focus join
font join line
font style key
foreign key

L-O
left outer join ODBC Administrator
link ODBC Control Panel 

option
literal ODBC Driver Manager
locked field or record ODBC driver



Max Open Query button
Min operand
multiple-table query operator
navigation buttons Other button
New Query button outer join
Null output argument
ODBC owner

P-R
pane Query window
parameter record
parts record selector
password relationship
point size Remove button
primary key result set
procedure retrieve
query return
query channel return value
query definition right outer join
query design row
Query Now button

S
Save Query button SQL
SELECT statement SQL dialog box
self-join SQL statement
server static data
Sort Ascending button string
Sort Descending 
button

sub-select statement

sort order Sum
source application synonym
source document system channel
split bar system table

T-Z
table Use button
table definition user
Table pane value
Total box Values button
Total calculation view
Total field View Criteria button
Totals button View SQL button
translation option View Tables button



translator wildcard character
underlying table Zoom Field box



ODBC Drivers
Each ODBC driver has its own Help file (separate from Microsoft Query Help), which is 
installed automatically when you install the driver.    If you've installed any of the drivers 
listed below, you can click the driver name to display its Help file.    To return to Microsoft 
Query Help, you can do one of the following:

Choose the Back button in the Help window until you return to Microsoft Query Help.
Choose the History button in the Help window, and then select a Microsoft Query Help

topic you displayed previously.
From the File menu in the Help window, choose Open, then select the file 

MSQUERY.HLP from the MSQUERY directory.
From the Help menu in Microsoft Query, choose Contents.

For information about installing drivers, see the Microsoft Query User's Guide, Appendix B, 
"ODBC Drivers: Requirements, Installation, and Adding Data Sources."    For information 
about additional drivers that are available, contact Microsoft.
dBASE
Microsoft Access 
Microsoft FoxPro 
Paradox
SQL Server



Keyboard Guide
Microsoft Query has a set of keyboard shortcuts you can use to navigate in the Query 
window, and select, move, and otherwise work with items in the Query window.
Editing Keys
Function Keys
Navigation Keys
Selection Keys



DDE Commands
Overview

Activate Logoff
AllowEdit Logon
BuildSQL ODBCLogon
Close Open
Command QueryNow
Exit SaveAs
Fetch SetWindowState
Fetch.Advise UserControl
Fetch.Unadvise ViewPane



Overview Dynamic Data Exchange (DDE) Command Reference
You send DDE commands to Microsoft Query using the destination application's Execute 
command.    For example, in Microsoft Excel this is the EXECUTE command, in Microsoft 
Word it is the DDEExecute command, and in Microsoft Visual Basic it is the LinkExecute 
method.    Refer to your application's documentation for the syntax and description of its 
Execute command.
Most commands operate on the contents of the active Query window (the active window for
a DDE channel).    For example, commands such as Close or QueryNow are sent to the 
active window.    The active window is not necessarily the selected window.
Make sure that the command sent is appropriate for the active window.    By default, the 
active window is the one opened last.    You can use the Activate command to change the 
active window.



Activate Command (DDE)
See Also Example

Activates the specified Query window.    This command is used to change the active window
when more than one window is open.    It is available only on the system channel.

Syntax
Activate (queryname)
Argument Description
queryname The name of the Query window to activate



Activate Command Example

Suppose you've opened three Query windows: Query1, Query2, and Query3.    Because it 
was created last, Query3 is the active window.    The following Microsoft Excel macro 
statement makes Query1 the active window:
=EXECUTE(Chan,"[ACTIVATE('Query1')]")



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



AllowEdit Command (DDE)
See Also Example

Determines whether editing is allowed in a Query window.    This command is available on 
both the system channel and the query channel.    It is equivalent to Allow Editing on the 
Records menu. 

Syntax
AllowEdit (allowedit, locked)
or
Allow.Edit (allowedit, locked)
The two forms of syntax are equivalent.
Argument Description
allowedit Enables or disables editing in the Query window:

True = Editing is allowed.
False = Editing is not allowed.

locked Disables the Allow Editing command on the Edit menu:
True = Command is dimmed.
False = Command is available.



AllowEdit Command Example

The following Microsoft Excel macro initiates a DDE channel with Microsoft Query and 
allows the user to build a query.    The SQL statement on which the query is based is saved 
and later re-executed.    The macro then sends the AllowEdit command to Microsoft Query 
to turn off the ability to edit queries and disable the Allow Editing menu command.    
Sending the UserControl command to Microsoft Query again allows the user to view but 
not edit data in the data source.    Finally, data is returned to the worksheet, and the 
channel is closed.
Chan=INITIATE("MSQuery","System")
=EXECUTE(Chan,"[UserControl('&Return to Excel', 3, True)]")
Sql=REQUEST(Chan, "QueryDefinition")
...
=EXECUTE(Chan,"[BuildSQL('"&Sql&"')]")
=EXECUTE(Chan,"[QueryNow ()]")
=EXECUTE(Chan,"[AllowEdit(False, True)]")
=EXECUTE(Chan,"[UserControl('&Return Data', 3, False)]")
Rows=REQUEST(Chan,"NumRows")
Cols=REQUEST(Chan,"NumCols")
=SET.VALUE(OFFSET(!B1,0,0,Rows,Cols),REQUEST(Chan,"All"))
=TERMINATE(Chan)
=RETURN()



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



BuildSQL Command (DDE)
See Also Example

Builds an SQL statement one item at a time to create a new query on the DDE channel.    
This command is available only on the system channel.

Syntax
BuildSQL [(sqltext)]
Argument Description
sqltext A valid SQL statement.    If sqltext is 0 or not specified, the SQL statement is 

cleared.
Remarks
The BuildSQL command is useful for building long SQL statements.    For example, if an 
SQL statement is too long to send in a single Microsoft Excel macro statement, you can 
send it in several smaller pieces.
After you build an SQL statement, you can execute it using the QueryNow   command  .



BuildSQL Command Example

You could use the QueryDefinition request item in a Microsoft Excel macro to return the SQL
statement for a query:
Sql=REQUEST(Chan,"QueryDefinition")

Then you could use the BuildSQL command to resend the SQL string:
=EXECUTE(Chan,"[BuildSQL('"&Sql&"')]")



See Also
User's Guide:

Chapter 8, "Working with SQL"
Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Close Command (DDE)
See Also Example

Closes the current query.    This command is available on both the system channel and the 
query channel.

Syntax
Close ( )



Close Command Example

Microsoft Excel macro statement:
=EXECUTE(Chan,"[Close()]")

WordBasic macro statement:
DDEExecute Chan,"[Close()]"



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Command Command (DDE)
See Also

Sends an Execute [Open ( )] statement to Microsoft Query.    This command is provided for 
those macro languages, such as the Microsoft Excel macro language, that limit the length 
of command strings (commands used with the Execute statement).
This command is available only on the system channel.

Syntax
Command (opnum, execstring)
Argument Description
opnum A number from 1 to 3 that specifies how Microsoft Query receives the 

commands:
1 = Initializes the buffer in Microsoft Query with execstring (clearing the 
buffer if it exists), but doesn't execute the query.
2 = Concatenates execstring to the end of the buffer.
3 = Concatenates execstring to the end of the buffer and executes the 
complete command buffer.    Because the command buffer is cleared after 
execution, execstring can't be re-executed.

execstring Segments of an [Open ( )] command.    The entire string must be enclosed in 
single or double quotation marks.
Microsoft Query supports sending only the Open   command   using the 
Command command.

Note      This command is provided for Q+E compatibility only.    It is recommended that you
use the BuildSQL command, if possible, to send long SQL statements.



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Exit Command (DDE)
See Also

Exits Microsoft Query.    This command is available only on the system channel.
Syntax
Exit (exitall)
Argument Description
exitall Determines whether Microsoft Query will exit if queries on channels other 

than the one executing the Exit command are open.    This argument can be 
either True or False.
Use True to exit Microsoft Query regardless of which queries are open.    If 
Microsoft Query is under user control for another channel (that is, the 
UserControl   command   has been executed), this setting closes that channel 
and returns control to the application that started Microsoft Query in user 
control.
Use False to exit Microsoft Query only if any open queries were opened on 
the channel executing the Exit command.

Note      This DDE command is also used to quit Microsoft Query for the Macintosh. 



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Fetch and Fetch.Advise Commands (DDE)
See Also Example

The Fetch command retrieves data from Microsoft Query and sends it directly to the 
destination application.    
The Fetch.Advise command updates the destination application automatically as values in
Microsoft Query change, not just when the Fetch.Advise command is sent.
These commands are available on both the system channel and the query channel.

Syntax
Fetch.Advise (appname, topic, range, values)
Fetch (appname, topic, range, values)
Argument Description
appname The name of the destination application to which the data is to be sent.    

Here are the appname arguments you'd use for some applications:
Microsoft Access = MSAccess
Microsoft Excel = Excel
Microsoft Word for Windows = WinWord

topic The name of the worksheet, document, or control to which the data is to be 
sent.

range The area of the worksheet, document, or control to which the data is to be 
sent.

values The values to be retrieved from Microsoft Query (see the table below for valid
values).

Note The Fetch.Advise command automatically updates only query data, not request 
items or row#col# references.
The values argument can be one of the following.
values Description
Request item Specifies the information to return; for example, QueryDefinition. (See 

Requesting Information in Chapter 9, "Using Dynamic Data Exchange with 
Microsoft Query" in the Microsoft Query User's Guide for a complete list of 
request items.)

row#col# A reference to retrieve specific rows and columns, such as R3C5 from 
Microsoft Excel.

/Headers Retrieves column names.
/Rownum Retrieves row numbers.
All Retrieves all records.

Remarks
For Fetch.Advise, the channel created to return data to the destination application isn't 
closed until a Fetch.Unadvise or Close command is sent.



Fetch, Fetch.Advise Commands Example

This Microsoft Excel macro uses the NumRows and NumCols request items to return the 
number of rows and columns in the query, and then returns the values with column 
headings to a Microsoft Excel worksheet named Sheet1:
Rows=REQUEST(Chan,"NumRows")
Cols=REQUEST(Chan,"NumCols")
=EXECUTE(Chan,"[Fetch('Excel','Sheet1','R1C1:R"&rows&"C"&cols&"','All/

Headers')]")



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Fetch.Unadvise Command (DDE)
See Also

Removes the automatic updating feature set by Fetch.Advise and closes the channel 
opened by Microsoft Query to pass data to the destination application.    This command is 
available on both the system channel and the query channel.

Syntax
Fetch.Unadvise (appname, topic, range)
Argument Description
appname The name of the destination application to which the data is to be sent.    

(See the Fetch   command   for examples.)
topic The name of the worksheet, document, or control to which the data is to be 

sent.
range The area of the worksheet, document, or control to which the data is to be 

sent.
Remarks
Unlike the Fetch.Advise command, Fetch.Unadvise doesn't include a values argument.



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Logoff Command (DDE)
See Also

Logs off the specified data source.    This command is available only on the system channel.
Syntax
Logoff (source)
Argument Description
source The name of the data source you want to disconnect from.



See Also
Help:

Logon   Command  
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Logon Command (DDE)
See Also

Displays a dialog box that enables you to log on to a data source.    This command is 
available only on the system channel.

Syntax
Logon (source)
Argument Description
source The name of the data source you want to connect to. 



See Also
Help:

Logoff   Command  
ODBCLogon   Command  

User's Guide:
Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



ODBCLogon Command (DDE)
See Also Example

Allows an application to connect to a data source.    You can specify whether dialog boxes 
are presented to the user at logon time.    This command is available only on the system 
channel.

Syntax
ODBCLogon (connectstring, dialog)
Argument Description
connectstring A string that supplies information (such as the data source name, user ID, 

and password) required by a driver to connect to a data source.    This 
argument must follow the format required by the driver you're using.    (For 
more information on the connection string, see the documentation for your 
data source).

dialog A value specifying whether dialog boxes are displayed at logon time:
0 No dialog boxes are displayed.

1 Dialog boxes are displayed to obtain additional information from the user not 
provided by the connection string.

2 Dialog boxes are displayed with values from the connection string filled in as 
default values.

3 Same as 1, except that information not required to connect to the data source is 
dimmed.



ODBCLogon Example

This WordBasic macro uses the ConnectionString request item to return the string needed 
to connect with a data source.    If you save this string after a user logs on to a data source, 
you can use the ODBCLogon command to connect to the data source without user input.
Connstr$ = DDERequest$ (Syschan, "ConnectionString")
...
DDEExecute Syschan, "[ODBCLogon (Connstr$,0)]"



See Also
User's Guide:

Chapter 1, "Getting Started with Queries"
Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



Open Command (DDE)
See Also Example

Opens and executes a query and displays the data in the Data pane.    This command is 
available only on the system channel.

Syntax
Open (query)
Argument Description
query The name of the Microsoft Query file (for Windows, the file extension is .QRY) 

or Q+E file (Windows only; the extension is .QEF) that contains the query; or 
the SQL SELECT statement to execute.



Open Command Example

The following examples use a Microsoft Excel macro to open a query named Sales.
For Windows:
=EXECUTE(chan,"[Open('c:\msquery\sales.qry')]")

For the Macintosh:
=EXECUTE(chan,"[Open('drivename:msquery:sales')]")

This example opens the same query using a WordBasic macro:
For Windows:
DDEExecute chan, "[Open('c:\msquery\sales.qry')]"

For the Macintosh:
DDEExecute chan, "[Open('drivename:msquery:sales')]")

This statement uses an SQL SELECT statement to execute a new query:
=EXECUTE(chan,"[Open('SELECT * FROM pubs.dbo.titles')]")



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



QueryNow Command (DDE)
See Also Example

Executes the active query for the open DDE channel.    If you've used the BuildSQL     
command to build the query, this command executes the SQL statement in the buffer and 
opens a Query window.    This command is available on both the system channel and the 
query channel.

Syntax
QueryNow ( )



QueryNow Command Example

The following portion of a Microsoft Excel macro saves an SQL statement from a query and 
later sends the same statement to re-execute the query:
Sql=REQUEST(Chan,"QueryDefinition")
...
=EXECUTE(Chan,"[BuildSQL('"&Sql&"')]") 
=EXECUTE(Chan,"[QueryNow()]")



See Also
Help:

Query Now Command (Records Menu)
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



SaveAs Command (DDE)
See Also

Saves a new query's design, an existing query's design under a different name, or a query's
result set as a table.    Performs the same function as Save As on the File menu and is 
available on both the system channel and the query channel.

Syntax
SaveAs (queryname, destination)
or
Save.As (queryname, destination)
The two forms of syntax are equivalent.
Argument Description
queryname The new name for the query or table.
destination The name of the data source that the query or table file is to be stored in.    If 

you omit this argument, Microsoft Query automatically creates a query file 
using the data source the query was opened from.    (In Microsoft Query for 
Windows, a query file has the .QRY extension.) 
To save the query as a new Query Definition file, enter "QueryFile" as the 
destination argument.



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



SetWindowState Command (DDE)
See Also

Specifies whether the active window is normal, minimized, or maximized when opened.    
This command is available on both the system channel and the query channel.

Syntax
SetWindowState (state)
Argument Description
state A number from 1 to 3 that specifies the state of the active window:

1 = Normal
2 = Minimized (Windows only)
3 = Maximized



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



ViewPane Command (DDE)
See Also

Specifies which panes in the Query window are displayed.    This command is available on 
both the system channel and the query channel.

Syntax
ViewPane (pane)
Argument Description
pane A number from 0 to 3 that specifies which panes are displayed:

0 = Data pane only
1 = Data pane and Table pane
2 = Data pane and Criteria pane
3 = Data pane, Table pane, and Criteria pane



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"



UserControl Command (DDE)
See Also Example

Activates Microsoft Query and allows users to create, open, or edit a query as if they were 
running Microsoft Query as a stand-alone application.
This command is available only on the system channel.

Syntax
UserControl (exittext, appstate, newquery) 
Argument Description
exittext The name of the Exit command used to exit Microsoft Query after a DDE 

conversation.    If exittext isn't specified, Return is used.
appstate A number that specifies the state of the application:

1 = Normal
2 = Minimized (Windows only)
3 = Maximized
If appstate isn't specified, the current state of Microsoft Query is used.

newquery Specifies whether the Select Data Source dialog box is displayed when 
Microsoft Query is started during a DDE conversation. You can use True or 
False.
If newquery isTrue, the Select Data Source dialog box is displayed, asking the
user to select a data source.    If newquery is False (the default), no dialog box
is displayed and any open queries for that channel are accessible.

Remarks
User control ends when the user chooses Exit from the File menu in Microsoft Query for 
Windows or Quit from the File menu in Microsoft Query for the Macintosh.    Microsoft Query 
then returns to its previous application state and returns control to the destination 
application.    

Important      Do not allow an application that includes a time-out feature to time out 
before user control ends.
While Microsoft Query is running under user control, any new or existing queries are 
opened on the same DDE channel. 



UserControl Command Example

The following Microsoft Excel macro statement starts Microsoft Query as a maximized 
application. and replaces the Exit command on the File menu in Microsoft Query for 
Windows (or the Quit command on the File menu in Microsoft Query for the Macintosh) with 
the Return to Excel command.    Then it displays the Select Data Source box.
=EXECUTE(Chan,"[UserControl('&Return To Excel',3,True)]")



See Also
User's Guide:

Chapter 9, "Using Dynamic Data Exchange with Microsoft Query"





Undo Command (Edit Menu)
See Also

Reverses the most recent change you made to data or the query's design.    The name of 
the command changes to indicate what you can currently undo; for example, "Undo Current
Record."

Notes
You must undo your most recent changes to a field or record before you begin editing

another record or switch to another window.    You can move to another pane in the Query 
window and still undo changes to the last record you edited in the Data pane.

You can't undo the deletion of a record.    
Shortcuts
Keys: To undo typing in Microsoft Query for Windows, press ALT+BACKSPACE or CTRL+Z.

To undo typing in Microsoft Query for the Macintosh, press CONTROL+Z (extended
keyboard) or COMMAND+Z.
To undo changes in the current field in Microsoft Query for Windows, press ESC.    
(Press ESC twice to undo changes to the current record.)
To undo changes in the current field in Microsoft Query for the Macintosh, press 
ESC (extended keyboard) or COMMAND+PERIOD.    (Press ESC or COMMAND+PERIOD 
twice to undo changes to the current record.)



See Also
Cue Cards:

Undo Changes to Data
User's Guide:

Chapter 3, "Working with Data"



Cut Command (Edit Menu)
See Also

Removes the data you've selected and places it onto the Clipboard.    You can then paste it 
elsewhere.    Use Cut to save time and avoid typing errors when you want to move data 
from one cell in the Criteria pane or Data pane to another cell in the same pane, or 
between the two panes.    

Important      You may not be able to cut items under some circumstances.    For example, 
you can't cut data from a disabled field, a locked field or record, a field that requires a 
value, a query that uses more than one table, or a field that displays a total or the results 
of a custom expression.    

Notes
To reverse the most recent cut operation, choose Undo Current Record from the Edit 

menu. 
To insert the item in a new location or reinsert it in the same location, choose Paste 

from the Edit menu.
Shortcuts
Keys: In Microsoft Query for Windows, press CTRL+X.

In Microsoft Query for the Macintosh, press CONTROL+X (extended keyboard) or 
COMMAND+X.



See Also
Help:

Copy Command (Edit Menu)
Delete Command (Edit Menu)
Paste Command (Edit Menu)

Cue Cards:
Copy or Move Data
Delete Data

User's Guide:
Chapter 3, "Working with Data"



Copy Command (Edit Menu)
See Also

Copies the data you've selected onto the Clipboard.    You can then paste it elsewhere.    Use
Copy to save time and avoid typing errors when you want to copy data from one cell in the 
Criteria pane or Data pane to another cell in the same pane, or between the two panes.    
You can also use Copy to copy data to another application.

Note      If you're copying data to another application, and you want to include row or 
column headings with your data, use Copy Special from the Edit menu instead of Copy.    

Shortcuts
Keys: In Microsoft Query for Windows, press CTRL+C.

In Microsoft Query for the Macintosh, press CONTROL+C (extended keyboard) or 
COMMAND+C.



See Also
Help:

Cut Command (Edit Menu)
Cue Cards:

Copy Data to Another Application
Copy or Move Data
Insert a Value
Replace a Value 

User's Guide:
Chapter 3, "Working with Data"



Copy Special Command (Edit Menu)
See Also

Copies data from the result set, including row numbers or column headings, to another 
application.    After choosing this command, switch to the application into which you want to
paste data.    You can then paste data so it is either static or dynamic.    Choose Paste for 
static data and Paste Link for dynamic data.

Note      Some applications may use a different Paste command for pasting dynamic data.    
Check the Paste commands in your application to determine which one to use.

Dialog Box Options
Include Column Headings
Select this option to copy the selected data and the corresponding column headings from 
the Data pane.
Include Row Numbers
Select this option to copy the selected data and the corresponding row numbers from the 
Data pane.



See Also
Help:

Copy Command (Edit Menu)
Exit Command (File Menu - Windows)
Paste Command (Edit Menu)
Quit Command (File Menu - Macintosh)

Cue Cards:
Copy Data to Another Application
Copy or Move Data

User's Guide:
Chapter 3, "Working with Data"



Paste Command (Edit Menu)
See Also

Inserts the value from the Clipboard into a cell in the Criteria pane or Data pane.    Use 
Paste with Copy or Cut to copy or move a value. 

Note      To reverse your paste operation, choose Undo Current Record from the Edit menu.

Shortcuts
Keys: In Microsoft Query for Windows, press CTRL+V.

In Microsoft Query for the Macintosh, press CONTROL+V (extended keyboard) or 
COMMAND+V.



See Also
Help:

Copy Special Command (Edit Menu)
Cue Cards:

Copy Data to Another Application
Copy or Move Data

User's Guide:
Chapter 3, "Working with Data"



Delete Command (Edit Menu)
See Also

Removes the selected item without placing it onto the Clipboard.    Choose Delete when you
want to remove an item and don't want to paste it elsewhere.    You can delete:

A field list from the Table pane.
A column, row, or cell containing criteria in the Criteria pane.
A field or record of data in the Data pane.
Information in dialog boxes that you can edit.

Notes
To reverse the most recent deletion, choose Undo Delete <item> from the Edit menu.
If you can't delete data, it may be for one of the following reasons:
The Allow Editing command (Records menu) isn't checked.
The data source doesn't allow it.
The query has more than one table.
The query contains totals or custom expressions.
The field you're trying to edit is locked or disabled, or the field is in a locked record.
The data you're trying to edit is from a database that requires certain values in a 

field.



See Also
Cue Cards:

Copy or Move Data
Delete Data
Delete Part of a Query
Hide Columns
Undo Changes to Data

User's Guide:
Chapter 3, "Working with Data"



About Cue Cards
Cue Cards replaces the standard tutorial that typically requires you to follow a set path.    
Cue Cards operates more like a coach, helping you to work with your query as you learn.
You use Cue Cards and Microsoft Query at the same time, without having to switch back 
and forth between them.    Cue Cards walks you through common Microsoft Query tasks 
step by step.    You can use Cue Cards to help you create an entire query, or you can call on 
it when you want help with a specific task.
To display specific Cue Card topics
You can display specific Cue Card topics by:

Using Help Search to find a specific cue card.
Jumping to Cue Cards from Microsoft Query Help Contents or the See Also pop-up 

window in Help topics.
To close Cue Cards

Double-click the Control-menu box in Microsoft Query for Windows and the Control 
box in Microsoft Query for the Macintosh.



Create a New Table
See Also

A table is a collection of records about a particular category of information, such as a list of 
employees or a list of products your company sells.    
Fields are the building blocks of tables.    Each field contains information about one aspect 
of the category, such as a last name or a product ID.
You can use an existing table that's similar to the one you want to create as a template for 
your new table, or you can create your table from scratch.

Note    When you create a new table from an existing one, Microsoft Query doesn't include 
the data from the existing table in the new table.    To create a new table with data from one
or more existing tables, save a query's result set as a table.

To create a new table from scratch or by using an existing table as a template
1. From the File menu, choose Table Definition.

Microsoft Query displays the Select Data Source dialog box, where you select the data 
source you want to use for your table. 

Note    If the data source you want isn't listed, choose the Other button, and then select 
the data source you want from the ODBC Data Sources dialog box.    If your data source 
isn't listed in this dialog box, choose the New button to add a data source for an installed
driver.    Proceed to Step 2.

2. Select the data source you want, and then choose the Use button. 
Microsoft Query displays the Select Table dialog box that's appropriate for your data 
source. 

3. If you're creating a table from scratch, choose the New button.
-or-
If you're using an existing table as the template for your new table, select the table you 
want as the template, and then choose the View button.
As appropriate, Microsoft Query displays the New or View Table Definition dialog box, 
where you can add, remove, change, and rename fields (columns) to create a new table. 

To define fields in the table
1. Follow Steps 1 through 3 in the previous procedure.
2. In the Table Name box, type a name for your new table. If you're using an existing table 

as a template, replace the existing table name with the name you want for your new 
table.

Note    The number and type of characters allowed in the table name varies, depending 
upon your data source.    For more information, see the documentation that comes with 
the driver your data source uses, or contact the driver vendor.    (In Microsoft Query for 
Windows, click "ODBC Drivers" in Microsoft Query Help Contents to display a list of ODBC 
drivers whose Help you can access.)

3. In the Field Name box, type a name for the first field. 
4. In the Type box, click the arrow (or press ALT+DOWN ARROW in Microsoft Query for 

Windows) to display a list of data types.    Select one for the field. 

Note    The data types available vary, depending upon your data source.    For more 
information, see the documentation that comes with the driver your data source uses, or 
contact the driver vendor. 



5. If you want, select additional specifications for the field.    The options available vary, 
depending upon the field's data type. 
Length Microsoft Query displays the maximum number of characters allowed for 

the data type you selected, including decimal places for numeric types . 
You may be able to save disk space and help prevent data-entry errors by 
specifying the smallest possible number. For example, if postal codes are 
always 5 characters, you could specify a length of 5. 

Decimal Type the number of decimal places you want to display for numeric data 
types.

Required Select this option if you want to require that there always be data in the 
field. 

6. When you've finished, choose the Add button.
Microsoft Query adds the field to the Fields box in the lower part of the dialog box, and 
displays any additional specifications you made next to the field.

7. Repeat Steps 3 through 6 for each field you want to add to your table.

Note    You can't edit a field once you've added it.    If you want to make changes to a 
field, remove it and then add it again with the changes you want. Remove a field by 
selecting it in the Fields box, and then choose the Remove button.

8. When you've finished adding fields, choose the Create button.
Microsoft Query creates your new table in the location specified by your data source and 
displays a message confirming that the table was successfully created.

9. Choose the OK button.



See Also
Help:

Delete a Table
User's Guide:

Chapter 7, "Creating and Deleting Tables"



Delete a Table
See Also

If you no longer want a table, you can delete it. 

Warning    When you delete a table, you're also deleting all the data stored in it. After 
you've deleted a table and its data, you can't undo your deletion.

To delete a table
1. From the File menu, choose Table Definition.

Microsoft Query displays the Select Data Source dialog box, where you select the data 
source for the table you want to delete. 

Note    If the data source you want isn't listed, choose the Other button, and then select 
the data source you want from the ODBC Data Sources dialog box.    If your data source 
isn't listed in this dialog box, choose the New button to add a data source for an installed
driver.    Proceed to Step 2.

2. Select the data source you want, and then choose the Use button. 
Microsoft Query displays the Select Table dialog box that's appropriate for your data 
source.

3. Select the table you want to delete, and then choose the Remove button.
If you confirm the delete when Microsoft Query prompts you, it deletes the table and the 
data in it.



See Also
Help:

Create a New Table
Save a Query's Result Set as a Table

User's Guide:
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Save a Query's Result Set as a Table
See Also

You can create a new table using the fields and data in a query's result set.    You can then 
use a query to retrieve data from this new table. 
To save a query's result set as a table
1. Open or create the query containing the result set you want to save as a table.
2. From the File menu, choose Save As.

Microsoft Query displays the Select Data Source dialog box.

Note    If the data source you want isn't listed, choose the Other button, and then select 
the data source you want from the ODBC Data Sources dialog box.    If your data source 
isn't listed in this dialog box, choose the New button to add a data source for an installed
driver.    

3. Select the data source you want, and then choose the Save button.
If your data source stores data in tables (as do SQL Server and Microsoft Access), 

Microsoft Query displays a Save As Table dialog box.
If your data source stores data in files used as tables (as do Microsoft Excel and 

Microsoft Word), Microsoft Query displays a Save As dialog box.
4. Type a name for your new table.    

Leave the Save Indexes check box option checked if the result set you're saving as a new
table came from a table that already contained an index.    Microsoft Query will then try 
to create an index on the same fields in the new table as well.    (You create an index for a
table to help Microsoft Query find values more quickly in fields that you often search or 
sort.    Microsoft Query looks up the location of the data in the index.)    

5. Choose the OK button in Microsoft Query for Windows or the Save button in Microsoft 
Query for the Macintosh.

Note    Because the data in this table isn't linked to the source query, the data remains 
the same even if the data in the source query changes.



See Also
Help:

Delete a Table
Create a New Table
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View or Edit an Existing Query's SQL SELECT Statement
See Also

After you create a query, you can view its corresponding SQL SELECT statement.    If you 
want, you can modify a query by changing the SQL statement directly rather than making 
the equivalent changes in the Query window, or you can use the statement as the basis for 
a more complex query you can't create directly in the Query window, such as one that uses
a sub-SELECT statement. 

Note      You use the following procedure to view or modify only an existing SQL statement 
that returns a result set.    To execute a new SQL statement or an SQL statement that 
doesn't return a result set, choose Execute SQL.

To view or edit the SQL SELECT statement of a new or existing query
1. Create a new query, or open an existing query.
2. Click the View SQL button on the toolbar. (Or, from the View menu, choose SQL.)

Microsoft Query displays the SQL dialog box with the SQL SELECT statement that 
corresponds to the current query.

3. If you want to make changes, enter them into the SQL statement, and then choose the 
OK button.    (To add a new line in the SQL Statement box, press ENTER.)
Microsoft Query executes the SQL statement and displays the result set in the Data pane.
If the query wasn't executed successfully, Microsoft Query displays the SQL error 
message that corresponds to the problem.    Click the OK button to return to the SQL 
dialog box and correct the statement.

Notes
To change or replace the SQL statement, use the SQL syntax Microsoft Query uses or 

the syntax your data source supports. (See the SQL documentation for your data source.)    
Microsoft Query tries to interpret the syntax you use and display both the query's design and
its result set in the Query window.

If Microsoft Query can't display the query's design (because it can't interpret 
something in the syntax you used), it still displays the result set.    However, the only 
modifications you can make to the result set are formatting modifications, such as changes 
to the display font or column width.    You can't edit data, and you must make any changes to
the query definition, such as adding or removing fields or changing conditions, through the 
SQL dialog box.



See Also
Help:

Create a Query Using a Custom SQL Statement
Execute Procedures

User's Guide:
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Create a Query Using a Custom SQL Statement
See Also

If you can't create the query you want in the Query window, create it by defining and 
executing a custom SQL statement in Microsoft Query's Execute SQL dialog box.    You might
do this for queries that, for example, grant privileges, modify existing tables, or create 
indexes on data. 
To execute a new or existing SQL statement
1. From the File menu, choose Execute SQL.

Microsoft Query displays the Execute SQL dialog box. The current data source if there is 
one, is listed next to the Data Sources button in the lower-left corner of the dialog box. 

To execute an SQL statement on a table in another data source, choose the Data 
Sources button.    Select a data source from the Available Data Sources box in the Select 
Data Source dialog box, and then choose the Use button. 

Note    If the data source you want isn't listed, choose the Other button, and then select 
the data source you want from the ODBC Data Sources dialog box.    If your data source 
isn't listed in this dialog box, choose the New button to add a data source for an installed
driver.

To change the database, select a name from the Database list box.    (If your data 
source doesn't use the term database, the list box displays the label that's appropriate to 
your data source.)
2. In the SQL Statement box, type the SQL statement you want to execute.

-or-
Choose the Open button, select the file that contains the SQL statement you want to 
execute, and then choose the OK button.
Microsoft Query displays the statement in the SQL Statement box.

3. Choose the Execute button to run the query. Microsoft Query does one of the following:
If the query returns one or more result sets, Microsoft Query displays the first one in 

the Data pane.    (It doesn't display the others.)
If the query succeeds but doesn't return a result set, Microsoft Query displays a 

message that the statement was executed successfully.    (If the query affected rows in the 
underlying table, the message also specifies how many rows were affected.)
 If the query wasn't executed successfully, Microsoft Query displays the SQL error 

message that corresponds to the problem.    Click the ok button to return to the Execute SQL 
dialog box and correct the statement.
To save an SQL statement
1. In the Execute SQL dialog box, choose the Save button.

Microsoft Query displays the Save As dialog box.
2. Type a name and choose a drive and directory, or folder, where you want to store the 

query file, and then choose the OK button.



See Also
Help:
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Execute Procedures
See Also

If your data source contains procedures, you can display a list of them in Microsoft Query.    
You can then select the one you want to execute and paste it into the Execute SQL dialog 
box. 
To execute a procedure 
1. From the File menu, choose Execute SQL.

Microsoft Query displays the Execute SQL dialog box.    The current data source, if there is
one, is listed next to the Data Sources button in the lower-left corner of the dialog box.

To execute a procedure in a different data source, choose the Data Sources button, 
and then select the data source from the Available Data Sources box in the Select Data 
Source dialog box.    Choose the Use button.

Note    If the data source you want isn't listed, choose the Other button, and then select 
the data source you want from the ODBC Data Sources dialog box.    If your data source 
isn't listed in this dialog box, choose the New button to add a data source for an installed
driver.

To change the database, click the down arrow in the Database box, and then select 
the database from the list.    (If your data source doesn't use the term database, the list box 
displays the label that's appropriate to your data source.)

Note    If the data source doesn't have any procedures, the Procedures button is disabled.
2. Choose the Procedures button.

Microsoft Query displays the Select Procedure dialog box, which contains the list of 
procedures available through the current data source.

3. Select the procedure you want to execute, and then choose the Paste button.    (Or, 
double-click the procedure.)
Microsoft Query pastes the procedure statement into the SQL Statement box.    If the box 
contains text, Microsoft Query replaces it with the procedure statement.

Note    If the procedure contains input arguments, the names of those arguments are 
included in parenthesis.    Replace the argument names with the values you want to pass 
to the procedure.

4. Choose Execute to run the procedure.    Microsoft Query does one of the following:
If the procedure returns a result set, Microsoft Query displays it in the Data pane.    (If 

the procedure returns multiple result sets, Microsoft Query displays the first one in the Data 
pane.    It doesn't display the others.)

If the procedure succeeds but isn't the type that returns a result set, Microsoft Query 
displays a message that it was executed successfully. 

If the procedure wasn't executed successfully, Microsoft Query displays the 
appropriate error message from the data source to identify the problem.    Click the OK 
button to return to the Execute SQL dialog box and correct the statement.

Note    Microsoft Query can execute most procedures whether or not they return a result 
set. However, Microsoft Query doesn't execute procedures that have output arguments 
and doesn't show a return value from a function. 
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Use Your Own Expressions to Perform Calculations
See Also

You can create a field in the result set that displays the results of a calculation you define.    
This is useful when you want to use one or more types of totals in a calculation. For 
example, if employees receive a 15 percent commission on their total sales, you can 
calculate the commission by adding up each employee's sales and multiplying the total by 
0.15.
To perform a calculation using your own expression

In the Data pane, type the expression for the calculation in the blank column's 
heading, and then press ENTER.    (Or choose Add Column from the Records menu, and then 
type the expression in the Field box.)
Notes

If the Automatic Query option is turned on, Microsoft Query displays the results of the
calculation below the column heading displaying the expression.    If the Automatic Query 
option is turned off, click the Query Now button on the toolbar or choose Query Now from 
the Records menu to display the results.

How you formulate the expression depends on the data source you're using.    See 
your data source's documentation for more detailed information on expressions. 



See Also
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Expressions Overview
See Also Examples

Microsoft Query uses expressions for calculations and specifying criteria.    For example, the 
expression PRICE*QUANTITY multiplies the value in the PRICE field by the value in the 
QUANTITY field for each record.
In many instances Microsoft Query defines the expression for you.    

If you (a) click the Totals button on the toolbar or (b) choose Add Column from the 
Records menu, and then select a total from the Total box, Microsoft Query defines the 
expression for calculating the type of total you selected.

If you set criteria by clicking the Add Criteria button or by choosing Add Criteria from 
the Criteria menu, Microsoft Query translates the choices you make into an expression, and 
then places the expression into the Criteria pane.
In some cases, however, you define the expressions for Microsoft Query yourself.    This 
happens when you want to calculate values other than the totals you can choose in 
Microsoft Query, or when you prefer to set criteria by typing them directly into the Criteria 
pane.
The following is an example of an expression with its parts labeled.

This expression specifies the criterion "Average order amount is greater than 1000."
Parts of an Expression

Element Example Description
Operator *, +, <, >, And, 

Or, Between, 
Like

Indicates an 
operation to be 
performed on one 
or more elements

Identifier ORDER_AMT, 
PRICE*QUANTITY

Refers to the value 
of a field

Function Avg, Sum, Min Returns a value 
based on the 
results of a 
calculation or other 
operation. 

Literal 50, #1993-03-
29#, 'Susan 
Thomas'

Represents a 
number, string, or 
date that Microsoft 
Query uses as 
entered

Wildcard 
Character
s

%, _ Combined with part
of a value, 
represents pattern 
of characters to 
search for in the 
records.

Note    After you enter an expression into the Criteria pane, Microsoft Query automatically 
adds single quotation marks (' ') around text and number signs (#) around dates.    
However, it's a good idea to enter the single quotation marks and number signs yourself to 
make sure that Microsoft Query recognizes values correctly as text or dates.



Some data sources use characters other than quotation marks to surround text. To find out 
which characters your data source displays, see the documentation that comes with the 
driver your data source uses, or contact the driver vendor.    (In Microsoft Query for 
Windows, check the ODBC Drivers item in Microsoft Query Help Contents to see if your 
driver is listed.)

Tips
Numbers      Type only digits and decimal points.    Don't use currency symbols or the 

symbols for separating thousands (such as a comma).
Dates      Microsoft Query recognizes dates in a variety of formats.    In general, you 

can always use the format yyyy-mm-dd.    For example, you could type 1993-01-15 for 
January 15, 1993.

Text      If the text is more than one word, type single quotation marks around it.



See Also
Cue Cards:

Criteria Expressions
Multiple Criteria
Wildcard Characters



Functions
See Also

A function returns a value based on the results of a calculation or other operation.    For 
example, the Sum function returns the sum of two or more values.

Note    Microsoft Query assumes that your data source allows you to use the functions (also
called "Totals" in Microsoft Query) listed in the following table.    Some data sources support 
other functions as well.    To find out which functions your data source supports, see the 
documentation that comes with the driver your data source uses, or contact the driver 
vendor.    (If your data source uses an ODBC driver that came with Microsoft Query for 
Windows, click "ODBC Drivers" in Microsoft Query Help Contents, and then click the name 
of the driver.)

Function Returns
Avg The average of values in a field
Count The number of values in a field
Max The maximum value in a field
Min The minimum value in a field
Sum The sum of values in a field



See Also
Expressions Overview



Identifiers
See Also

An identifier is the name of an object in a data source.    Some examples of identifiers are 
database names, table names, and field names.    For example, ORDER_AMT is the identifier
(field name) for a field that contains the amount of each order.    You can also use an 
expression, such as "PRICE*QUANTITY", in place of an identifier.



See Also
Expressions Overview



Operators
See Also

An operator tells Microsoft Query to perform an operation.    For example, the + operator 
tells Microsoft Query to perform an arithmetic operation (addition).
Microsoft Query allows you to use arithmetic, comparison, and logical operators as 
described below.

Note    Microsoft Query assumes that your data source allows you to use the operators 
listed in the following tables.    Arithmetic operators may vary, depending upon your data 
source, but most data sources support the standard arithmetic operators.    Some data 
sources support additional operators not listed in the tables.    To find out which operators 
your data source supports, see the documentation that comes with the driver    your data 
source uses, or contact the driver vendor.    (If your data source uses an ODBC driver that 
came with Microsoft Query for Windows, click "ODBC Drivers" in Microsoft Query Help 
Contents, and then click the name of the driver.)

Arithmetic Operators
You use arithmetic operators to perform numeric calculations.    For example, the following 
expression uses the + operator to calculate the sum of order amount and freight: 
ORDER_AMT+FREIGHT
Arithmetic 
Operator Used to
* Multiply two numbers
+ Add two numbers
- Subtract one number from another
/ Divide one number by another

Comparison Operators
You use comparison operators to compare two values. For example, the following 
expression uses the < operator to determine if there are fewer than five units in stock.
UNITS_IN_STOCK<5
Comparison
Operator Meaning
< Less than
<= Less than or equal to
> Greater than
>= Greater than or equal to
= Equal
<> Not equal to

Logical Operators
You use logical operators with expressions that evaluate to true or false.    In the following 
example, the And operator combines the expression COUNTRY = 'Japan' with the 
expression COMPANY = 'Tokyo Traders.'    The entire expression evaluates to true if the 
COUNTRY value equals "Japan" and the COMPANY is "Tokyo Traders":
COUNTRY = 'Japan' And COMPANY = 'Tokyo Traders'
Logical
Operator Meaning
And This criterion and another criterion must be true for the records in the result 



set.
Or This criterion or another criterion must be true for the records in the result 

set.
Not This criterion must not be true for the records in the result set

Other Operators
The following table lists other operators you can use with Microsoft Query.

Operato
r

Example How used

Betwee
n

Between 10
And 100

To determine if a 
value falls within a 
certain range

In In('British 
Columbia', 
'Quebec')

To determine if a 
value is equal to 
any of several 
values in a list

Is Is Null
Is Not Null

With the keyword 
Null to determine if
a value is null (has 
no value) or not 
null (has a value)

Like Like 'Sm%' To compare two 
values using a 
wildcard character

See Also
Expressions Overview



Literals
See Also

A literal is a number, date, or text that Microsoft Query uses exactly as you enter it. Some 
examples of literals are 100 (number), #1993-01-15# (date), and 'British Columbia' (text).



See Also
Expressions Overview



Wildcard Characters
See Also

If you want to select records based on a pattern of characters, you can use wildcard 
characters such as the percent sign (%) or underscore (_).

Note    Wildcard characters vary, depending upon your data source.    To find out which 
wildcard characters your data source recognizes, see the documentation that comes with 
the driver your data source uses, or contact the driver vendor.    (If your data source uses an
ODBC driver that came with Microsoft Query for Windows, click "ODBC Drivers" in Microsoft 
Query Help Contents, and then click the name of the driver.)
The following table shows examples that use wildcard characters.

You can 
use

If you 
search for

Microsoft 
Query 
displays 
records with 
these values

An 
underscore 
(_) as a 
placeholder
for a single 
character.

Sm_th Smith
Smyth

A percent 
sign (%) as 
a 
placeholder
for a group 
of 
characters.

L%ng Ling
Doverling
Leka Travel and 
Trading
L378NG



See Also
Expressions Overview



Examples of Expressions
See Also

Here are some examples of expressions and the records included in the result set.
This expression Shows records 

where
'France' Value is France.
Not 'France' Value is not France.
In('France','Germany',
'Italy')

Value is France, 
Germany, or Italy.

<'M' Value begins with the 
letters A L

>='M' Value begins with the 
letters M  Z.

100 Numeric value is 100.
<=20 Numeric value is less 

than or equal to 20.
>=#1993-01-15# Date is on or after 

January 15, 1993.
Between #1993-01-
01# And #1993-12-
31#

Date is in the year 
1993.

Is Null The field does not 
contain a value.

Is Not Null The field contains a 
value.



See Also
Expressions Overview



Display the Same Total for Each Record in a Group
In some cases, you may want to display in the Data pane the total for each group of 
records in a query as well as the individual amounts that went into each total.    For 
example, you can display the total of all employees' salaries for a division in a company 
next to each individual salary amount.    If there are eight salaries, the total of those eight 
salaries is displayed next to each of the individual salary amounts.    You might do this if, for
example, you want to provide a side-by-side comparison of the parts (individual salaries) to
the whole (total salaries).

Note    Some data sources, including dBASE, don't support this type of operation.    If the 
data source doesn't support it, Microsoft Query displays an error message. 

To display the same total for each record in a group
1. Create a new query, and add the fields you want to use for grouping the totals (for 

example, Employee ID in the example above).
2. Add two instances of the field you want to total (Salary) to the Data pane. 

You use one instance to display the totals and the other instance to display the individual
amounts.

3. Select the field you want to use for displaying the totals, and then click the Totals button 
on the toolbar until the column heading indicates the type of total you want to calculate 
(Sum of Salary).    (Or double-click the column to display the Edit Column dialog box, and 
then select the total you want from the Total box.)    
Microsoft Query doesn't actually display the totals until you complete Steps 4 and 5.

4. Double-click the column heading for the field that will display the individual amounts 
(Salary).
Microsoft Query displays the Edit Column dialog box.

5. In the Total list box, choose the "For Each" option, and then choose the OK button.    
This tells Microsoft Query that for each individual amount in a group of records, it should 
display the total for that group in the totaled column.



Create a Join Not Based on Equality
See Also

The joins between tables in the Table pane don't have to be equi-joins.    For example, 
instead of selecting records based on equal values in the joined fields, you can select 
records based on one value being greater than, less than, or not equal to the other value.    
For example, you can create a greater-than join that compares the hire dates of employees 
to determine who has seniority.
You can use the following join operators:

does not equal 
is greater than
is greater than or equal to
is less than
is less than or equal to

To create a join not based on equality 
(The example referred to in parenthesis is based on a self-join on the Employee table in the 
Northwind Traders data.)
1. Create a query and add the tables containing the fields you want to join to the Table 

pane.    (Add the Employee table twice.)
2. Join the fields whose values you want to compare. (Join the HIRE_DATE fields.)
3. To change the comparison operator for the join, double-click the join line or choose Joins 

from the Table menu.    In the Joins dialog box, choose the operator you want to use, and 
then choose the Add button.    (From the Operator box, choose "is greater than.")

4. Add the fields you want to the Data pane.
Microsoft Query displays the records in the result set that meet the join condition.    (For 
the first column, add the FIRST_NAME field from the left table; for the second column, 
add the FIRST_NAME field from the right table.    For each employee in the first column, 
Microsoft Query displays the names of all employees who have seniority over that 
employee in the second column.)



See Also
Help:

Create a Self-Join
Cue Cards:

Change Join Type
Join Tables

User's Guide:
Chapter 6, "Creating Multiple-Table Queries"



Add Data Sources for Installed Drivers
See Also

When you're selecting a data source from the Select Data Source dialog box or the ODBC 
Data Sources dialog box, you may discover that the data source you want isn't listed.    
However, you can add the data source to the ODBC Data Sources dialog box, and from 
there add it to the Select Data Source dialog box.    You can add data sources from within 
Microsoft Query or from the ODBC Control Panel in Windows or the ODBC Configuration 
Manager Control Panel option on the Macintosh.
To add a data source to the ODBC Data Sources dialog box, its ODBC driver must already be
installed on your machine. For driver installation information and for information about 
adding data sources from the Control Panel, see Appendix B, "ODBC Drivers:    
Requirements, Installation, and Adding Data Sources" in the Microsoft Query User's Guide, 
or the ODBC Control Panel Option Help in Windows or the ODBC Configuration Manager 
Control Panel documentation for the Macintosh. 
To add a data source from within Microsoft Query
1. In the Select Data Source dialog box, choose the Other button.    Microsoft Query displays

the Select Data Source dialog box when you choose from the File menu New Query, Save
As, Table Definition, or Execute SQL (and then choose the Data Sources button).
Microsoft Query displays the ODBC Data Sources dialog box.

2. Choose the New button. 
Microsoft Query displays the Add Data Source dialog box in Microsoft Query for Windows 
and the Select DBMS Driver dialog box in Microsoft Query for the Macintosh, both of 
which list the ODBC drivers installed on your machine. 

3. In the Installed ODBC Drivers box, select the driver for the data source you want to add 
to the ODBC Data Sources dialog box, and then choose the OK button.
Microsoft Query displays a Setup dialog box or boxes specific to the data source you're 
adding.    It requests information about the data source, such as the name you want to 
assign to it and the database directory or folder.    (The name you assign to the data 
source is the name that appears in the ODBC Data Sources dialog box.)

4. Complete the dialog box and choose the OK button.
Microsoft Query redisplays the ODBC Data Sources dialog box with the data source you 
added. To use the data source for querying, you follow the procedure "To make a data 
source available for querying" under "Selecting a Data Source" in Chapter 1, "Getting 
Started with Queries."

Note      For information about modifying and deleting data sources for drivers that come 
with Microsoft Query, see the documentation that comes with the driver your data source 
uses, or contact the driver vendor.    (If your data source uses an ODBC driver that came 
with Microsoft Query for Windows, click "ODBC Drivers" in Microsoft Query Help Contents, 
and then click the name of the driver.)



See Also
Cue Cards:

Choose a Data Source
Your Data Source Isn't Listed

User's Guide:
Chapter 1, "Getting Started with Queries"



Create a Self-Join
See Also

If you want to compare values within a single table, you can use a self-join, which can be 
either an outer join or an inner join.    You create a self-join by adding two copies of the 
same table to a query.    For example, you can add two copies of the Employee table from 
the Northwind data to find out which manager each employee reports to.
If you use just one copy of the Employee table, the REPORTS_TO field shows you only the 
manager employee IDs, not his and her names.    If you use two copies of the same table 
and join the REPORTS_TO field to the EMPLOY_ID field, Microsoft Query can compare the 
data between the fields and determine which manager's name belongs with the employee 
ID in the REPORTS_TO field.
To create a self-join
1. Create a new query and add two copies of the same table to the Table pane.    (For the 

example above, add the Employee table twice.)
Microsoft Query adds "_1" to the title of the second copy to distinguish it from the first 
copy of the table.

2. Join the fields whose values you want to compare.    Use the = operator for the join.    You 
can see which operator Microsoft Query is using by double-clicking the join line or 
choosing Joins from the Table menu, and then selecting the fields for the right and left 
side of the join line.    (Join the REPORTS_TO field in the left table with the EMPLOY_ID field
in the right table.)

3. Add the fields you want to see to the Data pane.
(From the left table, add the following fields to the Data pane:    FIRST_NAME, 
LAST_NAME, and EMP_TITLE.    From the right table, add the LAST_NAME field to the Data 
pane.    To distinguish the last name of the employee from the last name of the manager 
the employee reports to, rename the LAST_NAME field (choose Edit Column from the 
Records menu) from the right table to "Manager."    In this example, you've told Microsoft 
Query to combine each employee's record in the first table with the record of the 
employee from the second table whose ID is in the REPORTS_TO field.    Since you added 
the MANAGER (LAST_NAME) field from the second table, Microsoft Query finds the last 
name of the person whose employee ID is the same as the ID stored in the REPORTS_TO 
field in the record from the first table.)



See Also
Help:

Create a Join Not Based on Equality
Cue Card:

Join Tables
User's Guide:

Chapter 6, "Creating Multiple-Table Queries"
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A
A display driver resolution of at least 400 x 350 pixels is required to run Microsoft Query.    

(Windows only)
Application is corrupted.

B
Between operator without And.

C
Can't access table <name>.
Can't add expression <name> to the sort list.



Can't apply aggregates to tables.
Can't create an empty table.
Can't create file.
Can't display the criterion.
Can't edit a calculated column.
Can't edit grouped query.
Can't edit multiple-table query.
Can't find record.    More columns are needed to identify it, or another user may have 

modified it.
Can't have outer joins if there are more than two tables in the query.
Can't open DDE channel; Microsoft Query couldn't find the specified application and topic.
Can't open file. (Windows only)
Can't open multiple copies of a file.
Can't paste.
Can't remove; some queries are using this source.
Can't save the column <name> to this data source.
Can't save to a file that is already open.
Can't set criteria unless you've specified a field.
Can't specify * as a field.    To add all fields, drag and drop * into the grid.
Can't start Microsoft Query.    Please try again.
Can't undo this operation.    Continue anyway?
Clipboard format not supported.
Column <name> can't be used in the criteria.
Column <name> can't be used with the operator <operator>.
Columns <name> and <name> that you are about to join are of different types.    Create 

the join anyway?
Couldn't access <database>.
Couldn't add data source.
Couldn't add the table <name>.
Couldn't create index
Couldn't create new window.
Couldn't fetch procedures.
Couldn't find Cue Cards; reinstall Microsoft Query.
Couldn't find the ODBC administrator; reinstall ODBC.
Couldn't open Clipboard.
Couldn't open file.
Couldn't open file <name>.
Couldn't read this file.
Couldn't remove data source.

D
Data format error; can't paste.
DDE conversation closed or changed.
Delete <number> record(s).
Delete table <name>?



Didn't expect <text> after the column list in the GROUP BY clause.
Didn't expect <text> after the column list in the ORDER BY clause.
Didn't expect <text> after the select list in the SELECT statement.
Didn't expect <text> after the HAVING clause.
Didn't expect <text> after the WHERE clause.
Driver error.

E
Error during save operation.
Error in the name <name>.
Executed SQL statement successfully.
Executed SQL statement successfully: <number> rows affected.
Existing tables can't be modified.    Changes can be used to create a new empty table.
Expected 'BY' after 'GROUP'.
Expected 'BY' after 'ORDER'.
Expected expression after 'GROUP BY'.
Expected expression after 'HAVING'.
Expected expression after 'ORDER BY'.
Expected expression after 'WHERE'.
Expected HAVING expression.
Expected 'JOIN' after 'OUTER'.
Expected join operator after table <name>.
Expected LEFT or RIGHT after table <name>.
Expected 'oj' after '{'.
Expected 'ON' after right join table.
Expected 'OUTER' after LEFT/RIGHT.
Expected table name after FROM.
Expression too complex.
Expression too long.
Expression too long for the QBE grid and has been truncated.
Extra ')'.

F G
Failed to create unique index.    Create one yourself?
File name isn't valid.
First select a data source.
Function <name> can't be used with <column name>.
General ODBC Error

H
Height must be between 1 and <number>.
Help isn't available due to lack of available memory or improper installation of Windows or   

Microsoft Query.
I R
I/O error during load.
I/O error during save.



Incompatible version of <file name>; Microsoft Query can't run.    (Windows only)
Incorrect column expression: <expression>.
Incorrect extension <extension>. (Windows only)
Index was created successfully.
Invalid table name.
Invalid use of '.', '!', or '( )'.
Left and right outer joins must be equi-joins.
Length <number> must be numeric.
Length specified must be greater than 0.
Maximum length for type <datatypename> is <number>.
Message queue filled; DDE message lost.
Missing ')', ']', or '|'.
Must have two instances of the table to create a self-join.
Must select one value for the operator <operator>.
Must select two values for the operator <operator>.
Need System 6.0.5 or higher to run. (Macintosh only)
No procedures found.
No unique indexes exist in this table.    Create one yourself?
Nonunique record found.
Not a recognized unit of measurement.
Not all functions supported by driver.
Not enough system resources to update display.
Number is too large.
Number of digits after the decimal should be less than or equal to the total length.
<Number> records match the selection.    Delete them all?
<Number> records will be updated.
Only two tables are allowed with an outer join.    Delete outer join to add table?
Out of memory during calculation.
Outdated <filename> file.    Please reinstall Microsoft Query.
Query can have only one outer join.
Record doesn't exist.
Refresh failed.
Remote links exist; close anyway?

S
Save changes to Query <name>?
Save failed: not enough connections available.
Save file as <name>. (Windows only)
Save large Clipboard from <name>.
Save stopped due to invalid query state.
Since the database is read-only, you can't create or remove tables.    Continue?
Some queries are using <connectionname>; close anyway?
SQL execution failed.
SQL Query can't be represented graphically.    Continue anyway?
Stop the save?



Syntax error.
Syntax error in date.
Syntax error in GROUP BY clause.
Syntax error in HAVING clause.
Syntax error in JOIN expression.
Syntax error in number.
Syntax error in ORDER BY clause.
Syntax error in string.

T
Table <name> already exists; replace it?
Table <name> already in the query; add it again?
Table <name> was created successfully.
Table <name> was deleted successfully.
Text too long; paste canceled.
The other application is busy.
The other application quit.
The other application won't perform the DDE operation you attempted.
The DDE transaction failed.    Check to ensure you have the correct version of DDEML.DLL. 

(Windows only)
Timeout while waiting for DDE response.
Too many values selected.

U Z
Unable to display Help. (Macintosh only)
Unable to execute query.    View SQL text?
Unable to quit Microsoft Query.
Unable to retrieve values.
Update failed.    Continue editing record?
<Value> exceeds the numerical range of this column.
<Value> has too many digits after the decimal.
<Value> isn't a Boolean value.
<Value> isn't a valid date.
<Value> isn't a valid number.
Value must be a number.
Width must be between 0 and <number>.




